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About this document

Scope and purpose

This guide provides comprehensive information on how to use the Device Firmware Update (DFU) Software
Development Kit (SDK) to develop DFU systems for Cypress PSoC 6 MCU products. A detailed description of the
SDK application programming interface (API), and build instructions for multiple bootloader code examples,
are included.
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1 Introduction

This guide gives an overview of device firmware update (DFU, also called "bootloader") fundamentals, followed
by a detailed description of the Cypress DFU Software Development Kit (SDK) and how to use it with
PSoC 6 MCU.

Note: The term “bootloader” has become overloaded in the industry and is frequently confused with the
device startup (“boot-up”) process. Therefore, this application note, and the associated code
examples are transitioning to “device firmware update”, or DFU, to reduce ambiguity.

Multiple development tools are covered in this guide, including Cypress’ ModusToolbox™ integrated
development environment (IDE) and Cypress' PSoC Creator IDE. ModusToolbox IDE is a free IDE for Windows®,
macO0S®, and Linux®. It provides a single, coherent, and familiar design experience for Internet of Things (loT)
designers, combining PSoC 6 MCU and the industry’s most deployed WiFi and Bluetooth technologies. For more
information on ModusToolbox IDE, click here.

PSoC Creator is a free Windows-based IDE that enables concurrent hardware and firmware design of systems
based on multiple Cypress PSoC MCU families. For more information on PSoC Creator, click here.

If you are new to DFU / bootloaders in general, basic concepts and design principles are explained in the next
section,What is Device Firmware Update?

If you are familiar with DFU concepts and want to see how they are implemented in PSoC 6 MCU, see the
sections DFU SDK Description, How to Use the SDK, and PSoC 6 MCU DFU Code Examples. For a list of the
DFU code examples, see Related Documents. For a complete list of PSoC 6 MCU code examples, click here.

Note: At the time of publication, UART-, PC-, SPI-, and BLE-based DFU systems are supported. Other
communication channels will be added in future SDK updates
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2 What Is Device Firmware Update?

Device firmware update (DFU) is a common part of MCU system design. DFU makes updating a product’s
firmware in the field possible. In a typical product, firmware is stored in an MCU’s flash memory. The MCU is
mounted on a printed circuit board (PCB) and embedded in a product, as Figure 1 shows.

Your Product

Circuit Board

Hardware
connection to

MCU Comm. outside world

Ch | m
ane _;l <—DFU data flow
Flash
Memory
- CPU
Figure 1 DFU Data Flow Block Diagram

At the factory, initial programming of firmware into a product is typically done at PCB assembly time, using the
MCU’s JTAG or SWD interface. However, these interfaces are not usually available in the field, and therefore are
generally not used for firmware updates.

A better way to update firmware in the field is to use an existing connection between the product and the
outside world. The connection may be a standard communication port such as I°C, USB, or UART, a wireless
channel such as BLE, or a custom protocol.
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2.1 Terms and Definitions

Figure 1 implies that the product’s embedded firmware must be able to use the communication port for two
different purposes: normal operation and updating flash. The portion of the embedded firmware that knows
how to update the flash is called a DFU module, or bootloader, as Figure 2 shows.

Target
MCU
Communication Host
Flash Memory Channel
¢ >
Application
File
Application
DFU module
Figure 2 Generic DFU System

Typically, the system that provides the data to update the flash is called the host, and the system being
updated is called the target. The host can be an external computer or another MCU on the same PCB as the
target.

The act of transferring data from the host to the target flash is called DFU, or a DFU operation (In previous
documentation, Cypress referred to the DFU as the bootloader. However, this term is frequently confused with
the boot-up process. Therefore, in this application note and associated code examples, we refer to this as DFU
to reduce ambiguity.) The data that is placed in flash is called the application or firmware image.
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into the correct location in flash, and control is
transferred to it. Figure 3 is a flow diagram that
shows how this works.

2.2 Using a DFU Module

The DFU module and the application typically
share a communication port. The first step in DFU
is to put the product in a mode where the DFU
module, and not the application, is executing. This
can be done in response to an event such as a
button press or a received command. The
application detects such an event and responds by
transferring control to the DFU module.

Device reset and initialization

DFU
module valid in
flash?

No
Halt execution

After the DFU module is running, the host can send
a “start DFU” command over the communication
channel. If the DFU module sends an “OK”
response, a DFU operation can begin.

Application
valid in flash?

2.3 Basic DFU Function Flow

During DFU, the host reads the file for the new
application, parses it into flash program
commands, and sends those commands to the DFU
module. After the entire file is received and
installed in target flash, the DFU module can pass
control to the new application.

Wait for
new application
from host?

No

Host comm.
start?

A DFU module typically executes first after device Wait forever?

reset.m. It can then perform the following actions:

e Check the new application’s validity before

transferring control to that application Receive new
imi P lication f
¢ Manage the timing to start host communication veo | ot
H Host comm. install in flash,
e DotheDFU operatlon start? overwriting
e Pass control to the new application aggl'it;’:%n

)

Go to application — —

2.4 Other Use Cases

Other more complex DFU use cases exist. A
common use case is for an application to be
running and have some event alert the application
that an update is available.

While the application continues to execute its Figure 3 DFU Function Flow
normal tasks, it also downloads the new

application into a temporary location. After the

new application is checked for validity, it is copied

11n atypical MCU, several events may cause a device reset: for example, a device power up or a voltage level on a reset pin. In addition,

firmware can trigger a reset by writing to a device register. This is known as a “software reset”, or SRES. Using the SRES feature, an

application can reset the device, for example in response to an event such as a button press. This effectively transfers control to the DFU

module because the DFU module executes first at device reset.
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3 DFU SDK Description

The Cypress DFU SDK is an API consisting of a set of callable functions and other elements that enable rapid
DFU system development. The SDK is shipped as a part of the Cypress PSoC 6 SDK. The SDK is typically found in
C:\...\ ModusToolbox_1.0\ libraries \ psoc6sw-1.0\ components \ psocémw \ dfu. The SDK may be used by other
IDEs as well as ModusToolbox IDE.

The SDK consists of the following:

e Source code (typically.h and .c files as well as linker scripts and .mk files) that implements the SDK API
e Documentation;i.e., this guide.
e Code examples

Note: You may modify the DFU SDK source code for custom purposes, for example to modify or add
commands to the host interface protocol (see Appendix B: Host Command/Response Protocol).

3.1 DFU SDK Files

Table 1 lists the files in the SDK.

Note: PSoC 6 MCU has two Arm® CPUs: a Cortex™-M4 (CM4) and a Cortex-M0+ (CMO0+). Linker script files are
provided for each CPU, for multiple IDEs. For more information, see AN215656, PSoC 6 MCU Dual-
CPU System Design.

Table 1 DFU SDK Files

File Description

cy_dfu.h, .c The DFU SDK files

cy_dfu_bwc_macro.h |Enables backward compatibility with the Cypress legacy Bootloader SDK

dfu_user.h Contains user-editable #define statements that control the operation

and the enabled features in the SDK
dfu_user.c Contains user functions required by the SDK:

Five functions that control communications with the DFU host; these are
also called “transport functions”

Two functions - ReadData () andWriteData () -thatcontrolaccess
to internal or external memory

The functions provided are defaults and may be modified for your

application
transport_uart.h,.c | Contains DFU transport functions for the host communication channel
transport_... .h, .c being used; these functions are typically called by the transport functions
in dfu_user.c
dfu_cm4.ld, Custom GCC linker In each application, these linker script files
dfu_cmOp.ld scripts replace the default linker script files; these files
dfu_cm4.scat, Custom MDK linker locate the code and data sections for each of
dfu_cmoOp.scat, scripts; the common the CPUs as well as the DFU module and other
dfu_mdk_common.h, |files exist to create regions.
dfu_mdk_symbols.c |necessary symbol
definitions.
Application Note 7 of 66 002-13924 Rev. *G
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File Description
dfu_cm4.icf, Custom IAR linker
dfu_cmOp.icf scripts

The files are organized in the DFU folder as Figure 4 shows:

\---dfu
| cy dfu.h
| cy dfu.c
| cy dfu bwc macro.h
\---config
| dfu user.h
| dfu user.c
| transport uart.h
| transport uart.c
| transport ... .h transport files for other
| transport ... .c communication channels
\---linker scripts
\---GCC
| dfu cmOp.1d
| dfu cmé4.1ld
\-—--MDK
| dfu cmOp.scat
| dfu cmé.scat
| dfu mdk common.h
| dfu mdk symbols.c
\---IAR
dfu cmOp.icft
dfu cmé4.icft
Figure 4 DFU SDK File Organization
Application Note 8 of 66 002-13924 Rev. *G
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3.1.1 User Callback Functions

The DFU SDK API functions call back to several user functions. This allows you to customize the following DFU
operations:

e Host communication, also called transport functions or communication interface functions

e Reading and writing device’s internal flash as well as other nonvolatile memory (NVM), for example external
flash

Table 2 lists_the required user callback functions. The DFU code examples show typical code for these
functions; see DFU Code Examples and Related Documents.

Table 2 User Callback Functions
Function ‘ Description
For Host Communication. Examples are in dfu_user.c and transport_xxx.h and .c files
Cy_DFU_TransportStart() Opens and initializes the communication channel
Cy_DFU_TransportStop() Closes the communication channel
Cy_DFU_TransportReset() Re-initializes the channel, typically to bring it back to a known

state

Cy_DFU_TransportRead() Receives a packet from the host; see Host Packet Structure
Cy_DFU_TransportWrite() Sends a packet to the host; see Host Packet Structure
For Non-Volatile Memory (NVM) Access. Examples are in dfu_user.c
Cy_DFU_ReadData() Reads data from the device flash or other NVM
Cy_DFU_WriteData() Writes data to the device flash or other NVM

3.1.2 Linker Scripts

A DFU system is a system with multiple applications (at least two) in NVM. You decide where in NVM each
application resides. The DFU SDK includes template linker script files (see Table 1 and Figure 4) that you can
adapt to your application. The DFU code examples include example linker script files.

3.2 DFU Ecosystem

Other elements of the DFU system are not included in the SDK. They are available in ModusToolbox IDE,
elsewhere in the PSoC 6 SDK, in the PSoC Creator IDE, or in the peripheral driver library (PDL), and can be used
by other IDEs:

e CyMCUEIfTool: cymcuelftool.exe in the folder ... \ ModusToolbox_1.0 \ tools \ cymcuelftool-1.0\ bin. This
program is called as part of building an application, as Figure 5 shows. (The diagram is similar for PSoC
Creator and other IDEs.)

e This program combines core and application image files into output files. It is a command line program; its
option syntax is documented in the Help command (-h / --help) output. A user guide is available in the
folder... \ cymcuelftool-1.0\ doc.

e Otherdrivers - for communication, flash, etc. - are in the folder... \ ModusToolbox_1.0\ libraries \
psoc6sw-1.0 \ components \ psoc6pdl \ drivers. They are called as needed by the DFU SDK API functions.

e Device Firmware Update Host Tool: dfuh-tool.exe in the folder... | ModusToolbox_1.0\ tools \ dfuh-tool-1.0.
This is an example of the “host” shown in Figure 2. For more information, see Appendix A, Device
Firmware Update Host Tool.
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Figure 5 ModusToolbox Application Build and DFU Process Diagram
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4 How to Use the SDK

This section describes the general process for using the DFU SDK. At a high level, the steps are Comparison of
Devices

o Determine the Applications in Your System
e Locate Applications in Memory

o Design the Applications

e Build and Program the Applications

For detailed instructions on how to build the DFU SDK code examples, go to DFU Code Examples.

4.1 Determine the Applications in Your System

The first step is to decide how many applications are to be in your design, and the purpose of each. Which
applications will have DFU capability? Figure 6 shows some typical memory maps for multiple applications:

e Map Ashows a basic case, where Application #0 downloads and installs Application #1.

e Map B shows a more complex case. There are three applications. All applications have DFU modules - they
can download and install any other application. (In practice, Application #0 is usually not updated.) A
general data section is located outside all applications.

e Map Cshows the same case as map B except that one of the applications is located in external nonvolatile
memory (NVM).

e Ineach of the maps, the DFU system uses a small amount of flash (typically one row) to store application
metadata. For information, see Appendix D, Application Metadata.

@ External NVM
Top of

user flash Application metadata Application metadata

Application #2
General data, e.g., log or
audio file

DFU SDK files

Application #2

- Top of
DFU SDK files user flash Application metadata

0x1008 0000

General data; e.g., log or
audio file

Application #1

Application #1
0x1008 0000

DFU SDK files

Application #1
0x1004 0000
DFU SDK files
Application #0 Application #0 0x1004 0000
Application #0
Start of DFU SDK files DFU SDK files Start of -
user flash user flash DFU SDK files

0x1000 0000 0x1000 0000

Figure6 Example DFU Memory Maps
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4.2 Locate Applications in Memory

The next step is to decide where each application is to be located in flash. There are several factors to consider:

e A maximum of 63 applications are supported, depending on the metadata size. For more information on
DFU SDK metadata, see Appendix D, Application Metadata.

e An application may have code and data for one or more CPUs, for example CM4 and CM0+in a PSoC 6 MCU
device. For more information, see the application note AN215656, PSoC 6 MCU Dual-CPU System Design.

e Thefirst application, usually called “App0”, must be located at the beginning of user flash, which in PSoC 6
MCU is at address 0x1000 0000, as Figure 6 shows. This is the first application to execute after device reset.?

Note: Another module, such as a Secure Image module in a secure system, may occupy address
0x1000 0000, and App0 may be located elsewhere in flash. For more information, see AN221111,
Creating a Secure System.

e Any application may incorporate the DFU SDK, and thus be able to download and install another
application, and/or transfer control to another application. In most cases, App0 should incorporate the DFU
SDK.

e When writing flash in non-blocking mode, PSoC 6 MCU has a read-while-write (RWW) capability across 512-
KB regions. That is, the DFU code may execute in one flash region while updating flash in another region. For
more information, see the PDL flash driver documentation and the device Technical Reference Manual
(TRM).

e Applications may reside in external memory as well as the device’s internal flash, as map C in Figure 6
shows. External memory is in a 128-MB sub-region from 0x1800 0000 to Ox1FFF FFFF.

Note: When executing out of external memory, the external memory device must be mapped into the
PSoC 6 MCU using the QSPI block in XIP mode. For more information, see the device Technical
Reference Manual (TRM).

e PSoC 6 MCU applications include validation bytes, which are saved in NVM, as part of the application. This
enables an application to be validated before transferring control to it.

Note: Depending on the security environment within which the applications exist, an application can be
structured for simple validation (with checksum or CRC data) as well as authorization (with
encrypted signature data). The DFU system can either directly implement validation or call a
function in the Flash Boot module to check authorization. For more information, see AN221111,
Creating a Secure System.

o NVM data that may be updated during the normal workflow, for example an events log, should not be part
of an application, because it makes the application difficult to validate. Instead, designate a region of NVM
thatis outside any application’s space and use it for data storage. Figure 6 shows two examples in maps B
and C.

e Reserve one row of flash for application metadata, as Figure 6 shows. (In rare cases more than one row may
be required.) Application metadata is managed by the DFU SDK and is used by applications to transfer
control to another application. Application metadata space should be outside any application space.

> The CMO+ CPU executes SROM and other system-level code first at device reset, then transfers control to the
application residing at 0x1000 0000. For more information, see the Technical Reference Manual (TRM).
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4.3 Design the Applications

4.3.1 ModusToolbox Instructions

Note: This section contains only DFU-specific instructions. For detailed step-by-step instructions for

creating a ModusToolbox application, see ModusToolbox Help; AN221774, Getting Started with
PSoC 6 MCU; or DFU Code Examples in this document.

The next step is to design each of the applications identified in the previous steps. Each application is a single
ModusToolbox application, independent from any other application. With ModusToolbox IDE, you can have all
the applications in one workspace, or in separate workspaces, as well as in separate locations on your
computer. Before getting started with PSoC 6 MCU, developing a plan for workspaces and applications for your
overall system development needs is recommended.

Note: A ModusToolbox application for PSoC 6 MCU (dual-CPU) is composed of five projects:

e <project name>_config: the device configuration file design. modus, and device configuration source files
e <project name>_mainapp: source files for the Cortex-M4 (CM4) CPU

e <project name>_mainapp_cmOp: source files for the Cortex-M0+ (CM0+) CPU

e <project name>_mainapp_psoc6pdl: driver files for the Cortex-M4 (CM4) CPU

e <project name>_mainapp_cmOp_psocépdl: driver files for the Cortex-M0+ (CM0+) CPU

Do the following for each ModusToolbox application that is to do DFU operations and/or be an installable
application:

e Ifthe application is to do DFU operations, enable a communication peripheral in the design.modus file. That
peripheral implements the communication channel to the DFU host.

e The DFU SDK includes support for many communication channel types, including UART, SPI, I°C, and BLE.
Code examples are available for each channel type; see DFU Code Examples and Related Documents.

e You can also create a custom communication channel. The driver must implement the transport functions
described in User Callback Functions.

e Incorporate the DFU SDK into the project, as Figure 7 shows. Right-click the _mainapp project in the Project
Explorer window and click ModusToolbox Middleware Selector.

miw-test - PSoC6DfuAppOUart_mainapp/readme:txt - ModusToolbox IDE

File Edit Navigate Search Project Run  WPL{ISS Middieware Selects
irg - [ ® - &~ @'

Search:
[ Project Explorer i3 | % Debug ifi} Begisters

| Middieware Components
» i PSoCEDfuAppOUart config [ €5D ADC ADC functionality using the CSD hardware, constructed to work on top of the C3D driver.,
15 PSoCEDfuAppOUart_mainaph

- =% PSoCEDfuAppOUart mainapp_cmlp
> 2% PSoCEDfuAppOUart mainapp_cm0p_psocbpd

> 15 PSoCBDfuApp0Uart_mainapp_psoctpdl [C] DFU SDK transport 12C L2 transport layer for Device Firmware Update Software Development Kit. Use it on top of
the DFU SDK Core.

[] DFU SDK transport SPI SPItransport layer for Device Firmware Update Software Development Kit. Use it on top of the
DFU SDK Core.

DFU SDK transport UART UART transport layer for Device Firmware Update Software Development Kit. Use it on top of
the DFU SDK Core.

[] Emulated EEPROM Allows creating an emulated EEPROM in flash that has the ability te do wear leveling and
restore corrupted data from  redundant copy. Operates on the top of the Flash driver from
PDL.

@

Figure7 Incorporate DFU SDK into a ModusToolbox Project

If the application will do DFU operations, select DFU SDK Core and a DFU SDK transport xxx box.
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Note: In most cases, only one transport box is selected. However, if you want to have a custom

communication channel, you can leave all transport boxes unselected, or even select multiple
boxes.

If the application is a downloadable application and will transfer control to another application, select DFU
SDK Core. The code to transfer control to another application is included in the DFU SDK core files.

Click OK when done. Required source..c, .h, and linker script (e.g., .[d) files are automatically added to the
project.

Repeat this step for the _mainapp_cmOp project; but select only the DFU SDK core box.

e Installed linker script files are by default set up for Application #0 (App0). For other applications, edit the
files by changing the application number. The following example shows edits for downloadable application
Appl, for the GCC linker, in dfu_cmOp.ld and dfu_cmA4.ld:

/*

* DFU SDK specific: aliases regions, so the rest of the code does not use

* application-specific memory region names

*/

REGION ALIAS ("flash coreQO",

REGION ALIAS("flash",

REGION ALIAS ("ram",

flash appl core0);
flash appl corel);

ram appl corel);

/* DFU SDK specific:
1;

sets an app Id */
__ Cy app_id =

e Change the project properties to use the DFU linker script files instead of the default linker script files. Select
the dfu_cm4.ld file for _mainapp, as Figure 8 shows. Include the relative path to the file. Select the
dfu_cmoOp.ld file for _mainapp_cmOp (not shown in the figure).

[ Project Explorer 52 | 43 Debug
> = PSoCeDfuApplUart_config

i1 Registers 72 (3

» (2% PSoCBDfuAppOUart_mainapp type filter text Settings frovr
+ 125 PSoCEDfulpp0Uart_mainapp_cmip . Resource
. 125 PSoCEDfuApp0Uart_mainapp_cm0p_psocpdl Builders i
» 2% PSoCEDfuAppOUart_ mainapp_psockpdl 4 C/Cos Build Configuration: |Debug [ Active ] - [Manage Configurations...|
Build Variables
Environment
Logging (@ Tool Settings )i Toolchains | B Devices | & Build Steps Build Artifact | [y Binary Parser| + | *
Settings’

Quick Panel

-Gt

Elll

ModusToolbox™ E

Tool Chain Editor
. C/C++ General
> MCU
Project References
Refactoring History
Run/Debug Settings
Task Tags
> Walidation

@

(% Target Processor

Script files (-T)

s 8

( Optimization
 Wamings

(# Debugging

a % GNU ARM Cross Assembler
(2 Preprocessor
(2 Includes
(2 Wamings
(# Miscellaneous

a % GNU ARM Cross C Compiler
(2 Preprocessor
(2 Includes
( Optimization
(2 Wamings
(# Miscellaneous

a %5 GNU ARM Cross C Linker
(2 General «l——

A Lihrarise

Apply and Close | |

Cancel

Figure 8

Application Note

ModusToolbox Project Properties Setting for Custom Linker Script
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e For downloadable application projects, add a post-build command to call the Cypress utility program
cymcuelftool.exe, as Figure 9 shows. cymcuelftool is included with your ModusToolbox installation. It
generates a *.cyacd? file, which is downloaded by the DFU host (see Figure 5). The post-build command is
done only for the CM4 binary. cymcuelftool combines the CM4 (__mainapp) and CM0+ (mainapp_cmOp)
projects to create the output.cyacd? file.

¢ Project Explorer 2 % Debug il Registers| i £ roPeTties for BS o0 e D i
> = PSoC6Dfussppl_config / e Sattings - .
4 =% PSoC6DfuAppl_mainapp

> @) Includes
» (= PSoC6Dfulppl_config ‘ . [Debu i Acie] ) e |
> (= psocGsw-10
ui
Environmen
Logging o _— | 8 Tool Settings | & Toolchains | Bl Devices [ Build Steps ) Build Artifact | fw Binary Parsers | © Error Parsers| L
Settings =
Tool Chain Editor Pre-build step:
bt EAC(J’ General Comman, d:
> 15 PSoC6DfuAppl_mainapp_cmip Proect Ref. -
» 125 PSoC6DfuAppl_mainapp_cm0p_psoctpdl R’“’f[() . E;E;:ES Description:
> 122 PSoC6DfuAppl_mainapp_psoctpd] un/Debug Settings
N Task Tags -
Validation
Post-build step
Comman d:
((Stey_sdlk install_dir}/tools/modus- shell-1.0/bin/bash --norc --noprofile S{workspace_loc/PSoC6DfuAppL_mainapp}/dfu_postbuild bash S{cy. )
Description:

)
)

Figure9 ModusToolbox Post-Build Command

The command typically invokes a bash file such as dfu_postbuild.bash in code example CE213903, PSoC 6 MCU
Basic DFU. For convenience, copy and paste the file into your _mainapp project.

Then change the _mainapp project properties to add command text similar to the following, as Figure 9 shows.

${cy sdk install dir}/tools/modus-shell-1.0/bin/bash --norc --noprofile
${workspace loc:/PSoC6Dfulppl mainapp}/dfu postbuild.bash

${cy sdk install dir}/tools/cymcuelftool-1.0/bin/cymcuelftool

${workspace loc:/PSoC6Dfulppl mainapp cmOp}/${config name:PSoC6DfuAppl mainap
p_cmOp}/PSoC6Dfurppl mainapp cmOp.elf

${workspace loc:/PSoC6Dfurppl mainapp}/${config name:PSoC6DfuAppl mainapp}/PS
oC6DfuAppl mainapp.elf ARM CM4

e Add code as needed to the main.c and other source files in both the CM4 (__mainapp) and CMO+
(mainapp_cmOp) projects. Specific requirements are:
- Adda#include "cy dfu.h" statementto all source files as needed to access the DFU SDK API.

- For downloadable applications, in main.c in the __mainapp_cmOp project, change the
Cy SysEnableCM4 () function call to:
Cy SysEnableCM4 ( (uint32 t) (& cy app corel start addr));

- For downloadable applications, in main.c in the __mainapp project, add the following global statement.
Adjust the array size for the selected signature type.
/* This section holds signature data for application verification. */

CY SECTION(".cy app signature")  USED static const uint32 t
cy bootload appSignature[l];
In your overall code in both main files, consider the following:

e Which DFU function(s) to call:

- Cy DFU Complete ():blocks while doing the entire DFU operation. Call this function if there is no
other task to do during DFU.
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- Cy DFU Init () followed by aseriesofcallstoCy DFU Continue():Cy DFU Continue ()
blocks while receiving, processing, and responding to one command packet from the host. Call these
functions if other tasks must be done during DFU.

e Whether each application shall pass control to another application. Add calls to DFU SDK API functions
Cy DFU ValidateApp () andCy DFU ExecuteApp () asneeded.

For more information, see the PDL DFU SDK documentation.

Note: You can copy and paste code from the code examples listed in DFU Code Examples and Related
Documents.

4.3.2 PSoC Creator Instructions

Note: This section contains only bootloader-specific (in ModusToolbox IDE, this has been changed to DFU

operation) instructions. For detailed step-by-step instructions for creating a PSoC Creator project,
see PSoC Creator Help; AN210781, Getting Started with PSoC 6 MCU with Bluetooth Low Energy
(BLE) Connectivity; or How to Build the Code Examples in this document.

The next step is to design each of the applications identified in the previous steps. Each application is a single
PSoC Creator project, independent from any other project. With PSoC Creator, you can have all projects in one
workspace (.cywrk file), or in separate workspaces as well as in separate locations on your computer. Before
getting started with PSoC 6 MCU, developing a plan for workspaces and projects for your overall system
development needs is recommended.

Do the following for each PSoC Creator project that is to be a bootloader or an installable application:

e Ifthe application is to do bootloading, place a communication Component on the project schematic; i.e.,
the TopDesign.cysch file. This Component implements the communication channel to the bootloader host.
Connect the Component terminals to the appropriate physical pins.

e The Bootloader SDK includes support for many of the communication Components in the PSoC Creator
Component Catalog, including UART, SPI, I°C, and BLE. Code examples are available for each
communication Component; see Bootloader Code Examples and Related Documents.

e For compatibility with the default transport files in the SDK, name the Component as UART, 12C, SPI, or
BLE.

e You can also create a custom communication channel. The driver must implement the transport functions
described in User Callback Functions.

e Incorporate the Bootloader SDK into the project, as Figure 10 shows. Right-click the project in the
Workspace Explorer window and select Build Settings.... In the Build Settings dialog, select Peripheral
Driver Library.
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(Build Settings e e |

Configurstion: [Debug (Active) ']
Toalchain: [ARM GCC 5.4-2016.92update -]
El-Bootloader Basic App0 UART @ Defautt (Tools > Options): C:\Program Files (<86}'\Cypress\PDLY3.0.1
B Code Generation
- Debug () Custom
Customizer
, Peripheral Driver Library Software package imports
i Target IDEs Expand g Collapse ¥/ Check All [T Uncheck All

CMO+ ARM GCC 5.4-2016-q2-update

- CM4 ARM GCC 5.4-2016-q2-update Package Variant Wersion Description
PDL
[ bootloader
é bootloader_sdk

-{¥] Core 2.0.0 |Bootloader SDK core files
App type Bootloader |2.0.0  |Files specific to a bootloader applications
Communication UART @ 200 UART communication files
{7] Communication BLE 2.0.0 |BLE communication files
-{T] Communication 12C 2.00 |I2C communication files
{7 Communication SPI 2.0.0 |SPI communication files

E-RTOS

B utilities

[ ok [ ey |[ conce

Figure 10 Incorporate Bootloader SDK into a PSoC Creator Project
If the application will do bootload operations, select Core, App type bootloader, and a Communication box.

In most cases, only one communication box is selected. However, if you want to have a custom communication
channel, you can leave all communication boxes unselected, or even select multiple boxes.

If the application is a downloadable application and will transfer control to another application, select Core.
The code to transfer control to another application is included in the SDK core files.

Click OK when done. Required source .c, .h, and linker script (e.g., .[d) files are automatically added to the
project.
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e Generate the project files. Click the project in B Workspace 'My_Bootloader_Basic' (1 Projects)
the Workspace Explorer window and select EI--EI Project ‘app0’ [CYBC6347BZI-BLD53] @
Build > Generate Application. The files are .j-% ;DP.DESET‘;‘J’;"" sy :
. . [ esign Wide Rescurces (app0.cydwr,
added to the project, as Figure 11 shows. (5 ARM GCC Ganeri ~N 3
e Note that PSoC 6 MCU has two Arm CPUs: CM4 - =[] bootload_common.Id §
and CM0+. Each CPU has its own folder, plus £ ARMIAR Generic . =
Generic folders and a shared files folder. Linker i jﬁﬂn\:ﬁgﬁé'wmm"cf E
. . - ENerc
scrlp_t files to locate the coc.le for each CPU, for | [8) bootload_mdk_commonth g
multiple IDEs, are automatically copied and \  /c] bootload_mdk_symbols.c J 5
added to the project. For more information, see EH CMOp (Core 0) 3
AN215656, PSoC 6 MCU Dual-CPU System (55 ARMGCCGeneric ) s
Desian. _’| bootload_cmp.ld
. g . | ] cyBebunT_cmOplus.|d ﬁ
e Figure 11 shows bootloader files added to the £ ARM IAR Generic =
CMOp folder. Similar files are also added to the _’| bootload_cm0p.icf
CM4 folder but are not shown. 1 eyBebix?_emOplusict
. . EH ARM MDK Generic
e Edit the files bootload _user.h and [ bootload_cmO0p.scat
bootload_user.c. Review the user callback ] cyBebux?_cmOplus.scat)
functions in bootload_user.c, and edit them for -3 Header Files
any customization that is needed, for example, EHO Source Files _
to write and read external memory. Usually the g ism ;%CG?":”";
functions can be left unchanged. AHE3) ARM MDK Generic
>ﬂ main_cmOp.c
Note: The bootload_user.c file that is “-|e] system_psoc62_cmOplus.c
. . =
added contains the default code for (D‘*_:' CM4 (Core 1)
. . B Shared Files )
UART. For other communication
. —|g] bootload_user.c
channels such as I°C and SPI, edit [0 bootload_user.h
bootload_user.c as follows: -] cy_ipc_config.c
0] cy_ipc_config.h
_ Change' -] cyapicallbacks.h
o " " -] systern_psocB3.h
#include "transport_uart.h [@] transport_uartc
to: \ -] transport_uarth )
#include "tr‘ansport_iZc .h" FH) Generated Source
or: . .
#include "transport_spi.h" Figure 11 . Add SDK Files to a PSoC Creator

or: Project
#include "transport_ble.h"
- Change five instances of “UART_Uart” to
“I2C_I2c”, “SPI_Spi”,or “CyBLE”.

e Depending on the compiler you are using, edit the appropriate common linker script file, to encode the
decisions made in Locate Applications in Memory. For an example, see Section 5.3 Step 9.

e Installed linker script files are by default set up for application #0 (app0). For other applications, edit the
files by changing the application number. The following example shows edits for app1, for the GCC linker, in
bootload_cmOp.ld and bootload_cmA4.ld-
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/*
* Bootloader SDK-specific: aliases regions, so the rest of the code does
not

* use application-specific memory region names

*/

REGION ALIAS ("flash core(O", flash appl core0);
REGION ALIAS ("flash", flash appl corel);
REGION ALIAS ("ram", ram appl corel);

/* Bootloader SDK-specific: sets App ID */

__cy app id = 1;

The Keil pVision MDK linker is more complex. The following example shows edits for applin
bootload_cmOp.scat and bootload_cm4.scat:

; Flash
#define FLASH START CY APP1 COREO_FLASH ADDR
#define FLASH SIZE CY APP1 COREO FLASH LENGTH

; Emulated EEPROM Flash area
#define EM EEPROM START CY APP1 COREO_EM EEPROM ADDR
#define EM EEPROM SIZE CY APP1 COREO_EM EEPROM LENGTH

; External memory

#define XIP START CY APP1 COREO SMIF ADDR
#define XIP SIZE CY APP1 CORE(O SMIF LENGTH
; RAM

#define RAM START CY APP1 COREO RAM ADDR
#define RAM SIZE CY APP1 COREO RAM LENGTH

And edits for Appl in bootload_mdk_symbols.c:

__cy app corel start addr EQU  cpp(CY APP1 CORE1l FLASH ADDR)

/* Application number (ID) */
__cy app_id EQU 1

/* CyMCUEl1fTool uses these to generate an application signature */
g9
__cy app_ verify start EQU  cpp(CY APP1 COREO_FLASH ADDR)

__cy app_verify length EQU  cpp(CY APP1 COREO FLASH LENGTH +
CY APP1 CORE1l FLASH LENGTH -
__CY BOOT_ SIGNATURE SIZE)
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e Change the Project Build settings to use the bootloader linker script files instead of the default linker script
files. Select the bootload_cmOp.ld file for the CM0+ CPU, as Figure 12 shows. Include the relative path to the
file. Select the bootload_cmA4.ld file for the CM4 CPU (not shown in the figure).

Note: Linker script files are provided for GCC, Keil uVision MDK, and IAR Embedded Workbench linkers.
The example shown is for GCC. Use the appropriate linker script for your IDE.

Note: This operation should be done for both Debug and Release configurations.

Workspace Explorer (1 project) > X
&g
] Werkspace 'My_Bootloader_Basic' (1 Projects) i [Debug {Aetive)
= 73] Project "app0’ [CY8C637BZI-BLD74]
-{&]' TopDesign.cysch

[}.__\P Design Wide Resources (app0.cydwr)

Toolchain: [ﬁF{M GCC 5.4-2016-g2-update

asunog

E-app0

EHC CMOp (Core 0) = [ Code Generaticn Additional Libraries
{3 HeaderFiles é - Debug Addtiortal Library Dir
E}_} Source Files % +- Customizer é‘:;'sﬁ;“'}ﬁeﬁles T
Lo e] main_cmOp.c = - Peripheral Driver Library Goom IIW%Script \bootlond cmbp 1d)
-3 bootload_cm[lp.icf/ - Target IDEs Ty p— :I'rue -
=)
- _] bootload_cm0p.ld 2 - CM0+ ARM GCC 5.4-2016-g2-update Use newlbnano  True
| ] bootload_cmOp.scat 3 - General Use newlib-nano Fo False
EHCD CM4 (Core 1) = - Assembler
_} Header Files g’ [ Compiler
[—]_} Source Files =+ Linker
Lo[e] main_cmd.c g
-] bootload_cmd.icf = i Optimization
-3 bootload_cmil.ld‘/ “-Command Line
-] bootload_cmd.scat t-User Commands

) Shared Files

-] bootload_common.icf
-] bootload_commen.ld
FH) Generated_Source

~CM4 ARM GCC 5.4-2016-g2-update Additional Libraries

£

Cl

[ General Additional libraries to link to the executable being
- Assembler created. The linker searches a standard list of dire...
£

i Compiler

B Linker -mcpu=cortex-mOplus -mthumb -L

. Generated_Source P SoCE -WI,-Map,${Output Dir}/
b General ${ProjectShortMame}map -T ‘bootload_cmp Id -
Crptimization specs=nano specs -W|,—gc-sections -g function-
H sections -Og ffat-to-objects

‘.-Command Line

- User Commands

Figure 12 PSoC Creator Project Build Settings for Custom Linker Scripts

e For downloadable application projects, add a post-build batch file to call the Cypress utility program
cymcuelftool.exe. cymcuelftool is included with your PSoC Creator installation. It generates a *.cyacd? file,
which is downloaded by the bootloader host (see Figure 5). The batch file is applied only to the CM4 binary.

Note:

1. See a Bootloader SDK code example such as CE213903, PSoC 6 MCU Basic Bootloaders, for an example of a
batch file. It is usually found in folder CE213903 \ Bootloader_Basic_Appl.cydsn. The batch file contents are
also available in Appendix E. For convenience, copy and paste the file into your PSoC Creator project folder
appl.cydsn.

2. Thenin PSoC Creator, in the Workspace Explorer window, add the batch file to the project’s Shared Files folder,
and add that file as a post-build command to the Cortex-M4 build, as Figure 13 shows.

3. This operation must be done for both Debug and Release configurations.
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Workspace Explorer (2 projects) - X\ Settings.
:% & | Conf i
Bl *Workspace 'CE213903' (2 Projects) anfiguratian [Debug (active) -
i 2] Project ‘CE213903_App0_UART [Cv8C637621-8L074] will Tocichen (AR GCC 5420 batepdas =
& Fa Project 'CE213003 Appl’ [CVBC637BZI-BLDTA] £
-&]' TopDesign.cysch 2 [=-CE213903_Appl 4 User Commands
P Design Wide Resources (CE212903_Appl.cydwr) Code Generation i
#+E3 CMOp (Core 0) ! - Debug post_build_core 1 bat creator ${OutputDirt ${Project ShortName?)
EHZ) CM4 (Core 1) Customizer
[=H ¥ Shared Files i~ Peripheral Driver Library
i-[n] bootload_mdk_common.h i--Target IDEs

G- CM0+ ARM GCC 5.4-2016-92-update
(&-CM4 ARM GCC 5.4-2016-g2-update )
[#- General
[ Aszembler

Compiler
[ Linker Post Build
B User Commands Specifies a custom command to execute after the build finishes:

+- User Commands

i+-|c] bootload_mdk_symbols.c
i-|n] bootload_userh
‘] post_build corel.bat
.-[} bootload_common.icf
--| ] bootload_common.ld
- CE213903.pdf

s)nsay | UolejUBWNIog | sjusuodwoy

"post_build_core1bat creator ${OutputDir} ${Project ShortName}"

oK [[ %y | concel

Figure 13 PSoC Creator Post-Build Command

Add code as needed to the two main_cmx.c and other source files. For downloadbale application projects, add
to the main_cm4.c file a global array to store the application signature. For example, for checksum, the simplest
and most common signature type, add the following:

/* This section holds signature data for application verification.
For checksum verification, set the number of elements in the array to 1,
and

in bootload common.ld set cy boot signature size = 4.
*/ B T - - -
CY SECTION(".cy app signature")  USED static const uint32 t
cy bootlocad appSignature[l];

In your overall code in both main files, consider the following:

e Which bootloader function(s) to call:

- Cy_Bootload_DoBootload(): blocks while doing the entire bootload operation. Call this function if
there is no other task to do while bootloading.

- Cy_Bootload Init() followed by aseries of callsto Cy Bootload Continue():
Cy_Bootload_Continue() blocks while receiving, processing, and responding to one command
packet from the host. Call these functions if other tasks must be done while bootloading.

e Whether each application shall pass control to another application. Add calls to Bootloader SDK API
functionsValidateApplication() and ExecuteApplication() as needed.

For more information, see the PDL Bootloader documentation.

Note: You can copy and paste code from the code examples listed in Bootloader Code Examples and
Related Documents.
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4.4 Build and Program the Applications

Build all the applications. Several output files are created, as Table 3 shows for ModusToolbox IDE. PSoC
Creator output files are similar. (See also Figure 5). All output files are in the Debug or Release folder of their
respective projects.

Table3 DFU Output Files for ModusToolbox IDE (Example from CE213903, PSoC 6 Basic DFU)

File Name ‘ Description
App0 with DFU module, for ModusToolbox IDE
PSoC6DfuAppOxxx_mainapp_cmOp.elf | Linker output, CMO+ project

PSoC6DfuAppOxxx_mainapp_cmOp_si cymcuelftool output after the signing process, CMO+ project
gned.elf

PSoC6DfuAppOxxx_mainapp.elf Linker output, CM4 project

PSoC6DfuAppOxxx_mainapp_signed.el | cymcuelftool output after the signing process, CM4 project
f

PSoC6DfuApp0Oxxx_mainapp_final.elf cymcuelftool final output, combining CM4 and CMO+ outputs.
This is the file that is programmed to the target device.

Appl, the downloadable application, for ModusToolbox IDE

PSoC6DfuAppl_mainapp_cmoOp.elf Linker output, CMO+ project

PSoC6DfuAppl_mainapp_cmOp_signe | cymcuelftool output after the signing process, CMO+ project
d.elf

PSoC6DfuAppl_mainapp.elf Linker output, CM4 project
PSoC6DfuAppl_mainapp_signed.elf cymcuelftool output after the signing process, CM4 project
PSoC6DfuAppl_mainapp_final.elf cymcuelftool final output, combining CM4 and CMO+ outputs.
PSoC6DfuAppl_mainapp_dfu.elf cymcuelftool final output, signed with CRC bytes. See

dfu_postbuild.bash.

PSoC6DfuAppl_mainapp_dfu.cyacd2 cymcuelftool downloadable output. See dfu_postbuild.bash.
This is the input to the Device Firmware Update Host Tool.

Program the App0..._mainapp_final.elf file into the device, using either ModusToolbox IDE or PSoC Creator. For
more information on device programming, see the Help menus in these tools.

At a later time, you can use the DFU module in Application #0, along with a host program, to download and
install application. cyacd?2 files into the device. See Appendix A. DFU Host Tool.
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5 PSoC 6 MCU DFU Code Examples

There are several code examples associated with this application note. They demonstrate the different ways
that DFU operations can be done.

A complete list of code examples and other documents, with download links on www.cypress.com, is
available in Related Documents.

Table 4 shows an overview-level list of the code examples:

Table 4 List of PSoC 6 MCU DFU Code Examples

CE# Title Description

Supports ModusToolbox IDE and PSoC Creator

CE213903 PSoC 6 MCU DFU Basic A set of examples that demonstrate basic DFU operations;
see Error! Reference source not found., memory map A:

Downloading an application from a host, using various
communication channels: UART, 12C, and SPI

Installing the downloaded application into user flash

Validating an application, and then transferring control to
that application

Supports PSoC Creator only

CE216767 PSoC 6 MCU with Same as CE213903, but uses BLE as the communication
Bluetooth Low Energy channel
(BLE) Connectivity
Bootloader

CE220959 PSoC 6 MCU BLE Same as CE216767, but saves the application temporarily
Bootloader with External in external memory, then copies it to its final destination in
Memory user flash

CE220960 PSoC 6 MCU BLE Same as CE216767; in addition the BLE stack can be
Bootloader with upgraded
Upgradeable Stack

CE221984 PSoC 6 MCU Dual- Same as CE213903, but demonstrates bootloading two
Application Bootloader applications, with a factory default (“golden image”) mode;

the communication channelis [2C

CE222802 Bootloader with Same as CE213903, but the application is encrypted and
Encryption and Signing signed for validation; the bootloader decrypts the
application and validates its signature; the communication
channelis UART

The following code examples are planned or are in development:

CE2xxxxx USB HID DFU Same as CE213903, but uses USB HID as the
communication channel
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CE# Title Description

Supports ModusToolbox IDE and PSoC Creator

CE2xxxxx USB Mass Storage DFU Same as CE213903, but uses USB Mass Storage as the
communication channel
CE2xXxxxx DFU with Multiple Same as CE221984; each application can update another
Applications application; see Figure 6, memory map B
CE2xXxxxx PSoC 6 MCU DFU with Same as CE213903, but the DFU source is external memory

External Memory Source

CE2xxxxx Embedded Host Program Similar to that described in AN60317, PSoC 3 and PSoC 5LP
12C Bootloader

Most of the code examples consist of multiple separate applications, called “App0” and “Appl”. In some cases,
additional applications, called “App2”, “App3”, and so on, are included. Each application is a separate
application in ModusToolbox IDE or a separate project in PSoC Creator.

Generally, all applications are in the same ModusToolbox or PSoC Creator workspace. As noted in Design the
Applications, projects can exist in separate workspaces as well as in separate locations on your computer.

Usually App0 does the DFU operation; it downloads and installs the other applications. One notable exception
is CE220960, BLE Bootloader with Upgradeable Stack - in that code example App1 downloads and installs
App2; App0 just transfers control to one of the other applications.

The basic code example, CE213903, has multiple '_AppO0_..."' projects; each project has a different
communication channel. Advanced communication channels such as BLE and USB are demonstrated in other
code examples.

The code examples support the CYS8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. Applications typically blink a kit
LED at different rates or in different colors, making it easy to tell which application is currently running. Porting
a code example to another kit or to your system is a straightforward task.

In general, the applications are designed such that you can transfer control from one application to another, by
holding a kit button down for 0.5 second. The BLE bootloader code examples use the Immediate Alert Service
(IAS) to transfer control between applications.

5.1 How to Build the Code Examples

The following are step-by-step instructions showing how to build each DFU code example listed inTable 4, with
optional adaptations for your application. For more information, see How to Use the SDK.

Note: When building the code examples, in many cases it is easiest to copy portions of the existing code
example into your project. The copied portions can then be modified for your application. The
portions to be copied are listed in each set of instructions.

The instructions are based on Cypress's ModusToolbox and PSoC Creator IDEs; they can be adapted for other
IDEs.
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5.2 PSoC 6 MCU Basic DFUs

This section shows how to build the basic DFUs in code example CE213903. There are five general steps:

e Create App0 and the workspace.

e Configure App0 as a DFU.

e AddAppl.

e Configure Appl as an installable application.
e Build and test the DFU and the application.

These steps apply to both ModusToolbox IDE and PSoC Creator:
5.2.1 ModusToolbox Instructions
1. Create AppO and the workspace.

Start ModusToolbox IDE, and select or create the workspace for your applications, as Figure 14 shows:

Eclipse Launch X

Select a directory as workspace

ModusToolbox IDE uses the workspace directory to store its preferences and development artifacts,

Workspace:  ChlUsersimemtw-myWorkspace - Browse...

[7] Use this as the default and do not ask again

b Recent Workspaces

Launch ] l Cancel

Figure 14 Define a ModusToolbox Workspace

Create a new application. The easiest way to do this is to click New Application in the Quick Panel window. In
the next dialog, click Dev/Eval Kit, and select CYS8CKIT-062-BLE for the CYS8CKIT-062-BLE PSoC 6 BLE Pioneer
Kit. Click Next.

In the next dialog, Starter Application, select EmptyPSoC6App, and change the Name. CE213903 uses
"PSoC6DfuAppOUart", "PSoC6DfuApp0I2c”, and "PSoC6DfuApp0Spi"; choose a name that indicates that this is
the application that does the DFU. You can also indicate the host communication channel. Click Next. In the
Summary dialog, confirm your selections and click Finish.

2. Configure App0 as a DFU.
To add DFU capability to an application, you must:

e Add a host communication channel to your design.
e Add other peripherals as needed
e Add DFU code
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e Add a communication channel. Open design. modus in project <name>_config. Select a channel type, and
configure it to work with the CY8CKIT-062-BLE kit:

- For UART: Add a UART to SCB 5, with the following changes from the default: Oversample = 12, Clock =
any convenient clock, RX =P5[0], TX = P5[1]. You can optionally assign names to the UART and the UART
pins.

- ForI?’C: Add an 12C to SCB 3, with the following changes from the default: Data Rate (kbps) =400, Clock =
any convenient clock, SCL = P6[0], SDA = P6[1]. You can optionally assign names to the 12C and the 12C
pins.

- For SPI: Add a SPI to SCB 6, with the following changes from the default: Clock = any convenient clock,
SCLK =P12[2], MOSI = P12[0], MISO = P12[1], SS1 = P12[4]. You can optionally assign names to the SPl and
the SPI pins.

e Add other peripherals as needed. For compatibility with CE213903, configure pins for kit LED and button
support:

- Configure pin P0[3] as follows: name = KIT_RGB_R, Drive Mode = Strong Drive Input Buffer off. Confirm
that the Initial Drive State = High (1).

- Configure pin P0[4] as follows: name = KIT_BTN1, Drive Mode = Resistive Pull-Up Input buffer on. Confirm
that the Initial Drive State = High (1).

e Add DFU code. Right-click project <name>_mainapp and select ModusToolbox Middleware Selector.
Select Middleware DFU SDK Core, and DFU SDK transport UART or one of the other transport options.

Do the same for <name>_mainapp_cmOp and select only DFU SDK core. Required source.c, .h, and linker
script (e.g., .ld) files are automatically added to both projects.

For I°C and SPI channels, edit the file dfu_user.c, in the <name>_mainapp project Source folder, as follows:

- Change #include "transport_uart.h" to:
#include "transport_i2c.h” or
#include "transport_spi.h".
- Change five instances of “UART_Uart” to “I2C_I2c” or “SPI_Spi”.

Integrate DFU code into the main.c files in <name>_mainapp and <name>_mainapp_cmO0p. The easiest way
to do this is to copy and paste the code from the code example CE213903, and then modify the code for
your application.

Right-click project <name>_mainapp and select Properties. In C/C++ Build > Settings > Tool Settings >
GNU ARM Cross C Linker > General, change the file in the Script files entry to dfu_cm4.1d, to link using the
custom scriptin the project. Do the same for project <name>_mainapp_cmOp, for dfu_cmOp.ld.

o Build the project. The easiest way to do this is to select <name>_mainapp, then in the Quick Panel click
Build <name> Application.

3. Add Appl.

As noted previously, with ModusToolbox IDE you can add applications to the same workspace as the DFU
application, or they can be in separate workspaces, folders, or both. These instructions show how to add Appl
to the same workspace as the DFU AppO.

Note: You can create any number of installable applications that work with the same DFU system. Before
getting started with developing applications, developing a plan for DFU and applications for your
overall system development needs is recommended. See Determine the Applications in Your
System.
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Create a new application in the same manner as described previously. Select the same kit as was done for
App0. Change the name; CE213903 uses "PSoC6DfuAppl". Choose a name that indicates that this is the
downloadable application.

4, Configure Appl as an installable application.

o Add other peripherals as needed. Edit design. modus for this application. For compatibility with CE213903,
configure pins for kit LED and button support:

Configure pin PO[3] as follows: name = KIT_RGB_R, Drive Mode = Strong Drive Input Buffer off. Confirm that
the Initial Drive State = High (1).

Configure pin P0[4] as follows: name = KIT_BTN1, Drive Mode = Resistive Pull-Up Input buffer on. Confirm
that the Initial Drive State = High (1).

e Add DFU code. Right-click project <name>_mainapp and select ModusToolbox Middleware Selector.
Select Middleware DFU SDK Core. Do the same for <name>_mainapp_cmOp. Required source.c, .h, and
linker script (e.g., .ld) files are automatically added to both projects. Adding DFU SDK Core to the application
is done only to enable transfer of control to AppO.

Edit the files dfu_cm4.ld in project <name>_mainapp and dfu_cmOp.ld in project <name>_mainapp_cmOp
as follows. This changes the application # for App1, and properly locates flash and RAM memory for App1:

/*

* DFU SDK specific: aliases regions, so the rest of code does not use
* application specific memory region names

*/

REGION ALIAS ("flash coreO", flash appl core0);

REGION ALIAS ("flash", flash appl corel);

REGION ALIAS ("ram", ram_appl corel);

/* DFU SDK specific: sets an app Id */
__cy app id = 1;

Note: It is important to not change anything else in these. ld files. With the exception of the above edits,
they must be the same as the App0. ld files.

Integrate DFU code into the main.c files in <name>_mainapp and <name>_mainapp_cmO0p. The easiest way
to do this is to copy and paste the code from the code example CE213903, and then modify the code for your
application.

Copy the file dfu_postbuild.bash from the code example into the project <name>_mainapp. See Appendix E.

Right-click project <name>_mainapp_cmOp and select Properties. In C/C++ Build > Settings > Tool
Settings > GNU ARM Cross C Linker > General, change the file in the Script files entry to dfu_cmOp.ld, to
link using the custom script in the project.

Do the same for project <name>_mainapp, for dfu_cm4. Id. Then, in the same window select Build Steps,
and replace the Post-build steps Command with the following:

${cy sdk install dir}/tools/modus-shell-1.0/bin/bash --norc --noprofile
${workspace loc:/PSoC6DfulAppl mainapp}/dfu postbuild.bash

${cy sdk install dir}/tools/cymcuelftool-1.0/bin/cymcuelftool
${workspace loc:/PSoC6Dfulppl mainapp cmOp}/${config name:

PSoC6DfuAppl mainapp cmOp}/PSoC6Dfurppl mainapp cmOp.elf
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${workspace loc:/PSoC6DfulAppl mainapp}/S${config name:PSoC6DfuAppl mainapp}/
PSoC6DfuAppl mainapp.elf ARM CM4

to create the output. cyacd2 file, which is used to download the application for DFU. See Appendix C.

o Build the project. The easiest way to do this is to select <name>_mainapp, then in the Quick Panel click
Build <name> Application.

5. Test the DFU and application.

Program App0 into a CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. Then use the Device Firmware Update Host
Tool (DHT) to download App1 to the kit; see tool usage instructions in Appendix A.

You can test the DFU and application using the instructions in the CE213903 document, Operation section.

5.2.2 PSoC Creator Instructions
1. Create AppO and the workspace.

You can create a PSoC Creator project and its containing workspace at the same time. In PSoC Creator, select
File > New > Project.... The Create Project window with the Select project type panel appears, as
Figure 15 shows.

e Click Target device.
e In the first drop-down menu, select PSoC 6.

e Inthe next drop-down menu, select CY8C6347BZI-BLD53. This is the PSoC 6 MCU device that is installed in
the CYSCKIT-062-BLE PSoC 6 BLE Pioneer Kit.

e Click Next.

[ Create Project - CYSC6347BZ1-BLDS: )

Select project type
Choose the type of project — design, library, or workspace.

Design project:

() Target kit:

. B c

() Target module: /
¥t

@ Target device: |PSoC 6 w || Last used: CYBC6347BZ1-BLDR3 -
= Last used: CYBCRI47BZI-BLDEI

e =2 PSoC 60

(71 Waorkspace EEEE E}

PSoC 63
<launch Device Selectar.. >

T |

Figure 15 PSoC Creator Select the Target Device

Click Next on the next two panels, select project template and Set target IDE(s). The Create Project panel
appears, as Figure 16 shows.
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Enter the Workspace name and select its Location. Set Project name to “app0”. Click Finish.

A new folder is created in the indicated location; the folder name is the same as the workspace name. A folder
appO.cydsn is created within the workspace folder; the. cydsn folder contains all project files.

Create Project
Choose a name and location for your design.

Workspace name:  My_Bootloader_Basic

Location: ChUsers‘mkea' Deskiop

Project name: appl]|

Figure 16 Create the PSoC Creator Project

The new workspace and project files are shown in the Workspace Explorer window; see Figure 11.
2. Configure AppO as a Bootloader.

To add bootloader capability to an application, you must:

e Add acommunication Component to the project schematic. Use this Component to communicate with your
bootloader host.

e Add other Components to the project schematic as needed for your application.
e Add Bootloader SDK and template files to the project.

Application Note 29 of 66 002-13924 Rev. *G
2021-03-31



PSoC 6 MCU Device Firmware Update Software Development Kit
Guide

PSoC 6 MCU DFU Code Examples

infineon

Add a communication Component. Open or double-click the project schematic (file TopDesign.cysch in the
Workspace Explorer window).
Open the Component Catalog, and navigate to your desired communication Component, for example UART,
as Figure 17 shows. Drag the Component onto the schematic.

b= -0 -l B I 175k M CRS TR A N
SErtPage( TopDesign.cysch D - d X (Component Catalog (123 componenisD >~ 31X
o [ | | o
éﬁ Search far...
( Cvpress) Off-Chip 4 b

UART_1

UART

Standard

LI

- — ESR UART (SCB) [w2.0]

-1<_>§ CapSense

=168 Communicaticons

i ﬂ Bluetooth Low Energy (BLE) [v2.0]
F-gg 12C

Fgg 125

ﬂ PDM to PCM (fixed function) [v2.0]
%8 SPI

Bk UART

m

m

B Digital
B Display
[

£

t- Ports and Pins
H-e System -

Open datashest
UART (SCE) communications interface

Inst_N
UART

Page 1

4Pk Standard

0 Errors 0 Warnings 0 Motes

Figure17 Add aPSoC Creator Communication Component to a Bootloader Project
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Double-click the Component on the schematic to configure its parameters, such as baud rate, number of
bits, etc., as Figure 18 shows.

Figure 18 shows the changed parameter settings for this code example; note that Name is changed from
UART_1to UART, 12C_1to 12C, or SPI_1 to SPI. This is recommended to work with the default Bootloader
SDK files that are copied to your project later.

When done configuring the Component, click OK.

Configure 'SCE_UART_PI Configure 'SCB_I2C_PDI
Name:  (( 1EE rame: (22
" Basic | Advanced | Pins | Builtin b " Basic | Pins | Buitin 4k
El Clock Seurce = Clock Seurce Iy‘paz .junuue &
alue
Enable Clock From Terminal |7 Enable Clock frem Terminal ] f(®) | |Parameter: SDataRate ‘=
El General S E==d Description: This parameter L
Com Mode Standard v | fo Mode Slave ~ || 69 | specifies the data rate in kbps. The
actual data rate may differ from
TX/RX Mede TX + RX + [ 7o Data Ra 400 19 | lthe selected data rate duetathe -
——1 [Actual baud rate (bps): 115741 -
Baud Rate (bps) 115200 f0 sl RO 109 N actual data rate (kbps): 400
Use RX FIFC ki 1 i)
e 12 f0 L se J 9 | |sCB clock (kHz): 12500 (3)
= Slave
Bit Order LSE First - || (g
Slave Address (7-bif) 0408 fod
Data Width 8 bits - —
ftd Slave Address Mask (8-bit) 0xFE f0d
Parity M =
ey one i) Accept Matching Address in RXFIFO | ] fd
Stop Bits 1 T |[ £ Accept General Call Address [&] 60
Enable Digital Filter ] ftd Enable Wakeup from Deep Sleep Mode  |[] 0
[ configure 'sCB_SPLPDI [F )
Name:  ('sPI
.~ Basic Advancad Pins Builtin 4k
B Clock Source mve: uamfﬂ
alue
Enable Clock from Terminal ] f) ||Parameter: SRxDataWidth
&) General Description: This option defines the
Mode Slave ~ || 76 | wicth of 2 single data element for the
RX direction in bits. This number must
Sub Mode Motorola || 769 | | match with TX Word Wictth for sll SPT
SCLK Mode CPHA =0, CPOL =0 = [t | 2o modes E‘“ﬁ\;l’:‘:‘;‘;’r‘:}'
Data Rate (kbps) 1000 ftu) ||The range: ¢-16.
Enable Input Glitch Filter ] fi)
Enable Wakeup from DespSlesp |71 fi)
) Dats Confiuration
Bit Order MSB First [~ [ fe0
RX Data Width E ftd
X Data Width 5 fi)
) Slave Select
S50 Polarity [ Active Low [ [
Actual data rate (kbps): 1094391 (i)
ss [
seuk
[y rprfryripriry
Mos! l o7 D5 D5 D¢ 0¥ D2 D1 Do
MISO o7 D6 D5 D4 D3 D2 D1 DO
[ N |

Figure 18 Configure the PSoC Creator Communication Component: UART, 12C, or SPI

Add other Components. Add other PSoC Creator Components such as LED and button pins to the project

schematic. The easiest way to do this is to copy and paste portions of the project schematic from the code
example CE213903, and then modify the schematic as needed for your application.

In the Design Wide Resources window, Pins tab, connect the UART, I2C, SPI, and other Component pins to
the appropriate physical pins. Use CE213903 and the guide for your kit for instruction.

Add Bootloader code to the project. First, incorporate the Bootloader SDK into the project - see Figure 10.

Then select Build > Generate Application. When done, the project should look like Figure 11, with the
addition of some startup and other non-bootloader files.
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For I°C and SPI bootloaders, edit the file bootload_user.c, in the project Shared Files folder, as follows:

- Change #include "transport_uart.h" to:
#include "transport_i2c.h” or
#include "transport_ spi.h".
- Change five instances of “UART_Uart” to “I2C_I2c” or “SPI_Spi”.

Add bootloader code to the main_cmOp.c and main_cm4.c files. The easiest way to do this is to copy and paste
the code from the code example CE213903, and then modify the code for your application.

o Build the project. Change the project build settings to use the template linker script files; see Figure 12.
Then select Build > Build app0.

3. Add Appl.

As noted previously, with PSoC Creator, you can add other projects — applications - to the same workspace as
the bootloader application, or they can be in separate workspaces, folders, or both. These instructions show
how to add App1 to the same workspace as the bootloader App0.

Note: You can create any number of installable applications that work with the same bootloader. Before
getting started with developing applications, developing a plan for bootloader and applications
for your overall system development needs is recommended. See Determine the Applications in
Your System.

In the PSoC Creator Workspace Explorer window, right-click the Workspace, then select Add > New Project...,
as Figure 19 shows:

Workspace Explorer (1 project) > 3 X Start Page * TopDesign.cysch

% o A
&I Workspace 'My_Bootloader Basic' (1 Projects) NG
EEI Project "app0’ [ Add b | Mew Project... |

~158] TopDesign.cy ... . i
E]".jﬂ; Defign ‘f."idej Build All Projects Fé& Existing Project...

EHES C|’-.,-'|[]p|:core]§ Clean All Projects £i] Mew Item...
£ Header Fil £ Clean and Build All Projects i| Existing Irem...
EHD Source Fil
- i[e] main. Update Components... L4 Mew Workspace Folder

Figure19 Add a New Project to a PSoC Creator Workspace

The Create Project window with the Select project type panel appears; see Figure 15. Make sure that the device
selected is the same as for App0. Click Next.

Click Next on the next two panels: Select project template and Set target IDE(s). The Create Project panel
appears.
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Set Project name to “appl”, as Figure 20 shows. The default Location is the workspace folder. Click Finish.

A new appl.cydsn folder is created within the workspace folder; the .cydsn folder contains all project files.

17BZI-BELDS:

Create Project
Choose a name and location for your design.

Add to cumrent workspace

My _Bootloader_Basic

Location: CiUsers\mkeaDesktop’My_Bootloader_Basic

Project name: app|

Figure 20 Create a Second PSoC Creator Project

4. Configure Appl as an installable application.

Note: Appl should be built with the same toolchain (GCC or MDK) as App0, or application transfer may
fail.

e Add other Components such as LED and button pins to the project schematic. The easiest way to do this

is to copy and paste portions of the project schematic from the code example CE213903, and then modify
the schematic for your application.

In the Design Wide Resources window, Pins tab, connect the Component pins to the appropriate physical
pins. Use CE213903 and the guide for your kit for instruction.

o Add Bootloader SDK and template files to the project. Incorporate the Bootloader SDK into the project;

see Figure 10. Select only the Core box, because Appl is a downloadable application and does not have
bootloader capabilities.

Then, select Build > Generate Application. When done, the project should look like Figure 11, with the
addition of some startup and other non-bootloader files. Change the project build settings to use the
template linker script files; see Figure 8.

Add a post-build batch file to the Shared Files folder, as described in Section 4.3 Step 8. Then add a post-
build command to the Cortex-M4 build - see Figure 13.

o Edit files. Edit the linker script files as described in Section 4.3 Step 6.

Add bootloader code to the main_cmOp.c and main_cm4.c files. The easiest way to do this is to copy and
paste the code from the code example CE213903, and then modify the code for your application.
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Make sure that an array has been added to the main_cm4.c file for the application signature, as described in
Section 4.3.2 Step 8.

o Build the project. After all build setting changes and file edits are complete, select Build > Build app1.

5. Test the bootloader and applications.

Program app0 into a CYS8CKIT-062-BLE PSoC 6 BLE Pioneer Kit. Then use the Bootloader Host Program (BHP)
to bootload app1 to the kit; see BHP usage instructions in Appendix A.

You can test the bootloader and applications using the instructions in the CE213903 document, Operation
section.

5.3 PSoC 6 MCU BLE Bootloaders
This section shows how to build three different BLE bootloaders in code examples:

e CE216767,PSoC 6 MCU with Bluetooth Low Energy (BLE) Connectivity Bootloader
e CE220959, PSoC 6 MCU BLE Bootloader with External Memory.
e (CE220960, PSoC 6 MCU BLE Bootloader with Upgradeable Stack (see this subsection).

These code examples are similar to the basic bootloaders code example, with some additional features:

e CE216767 downloads a new application directly
into flash, as Figure 21 shows.

Bootloading DFU

e CE220959 downloads a new application into "
Utilit
temporary storage in an external NVM (kit IC U4, J T/ BLE (App0)
|

Cypress 512-Mbit serial NOR flash), and then

copies it to its final destination in the PSoC 6 * .
MCU device flash, as Figure 22 shows. BLE BLE | Application
Applications (Appl)

e The bootloader (App0) and the application
(Appl) each have their own separate copy of the
BLE stack code, as Figure 21 and
Figure 22 show. Each copy occupies more than
128 KB of flash.

For a bootloader with a single shared BLE stack,
see BLE Bootloader with Upgradeable Stack.

Figure 21 Data and Control Flow for CE216767

Load
Bootloading Bootloader >
Utility (App0) Copy
External
v NVM
BLE BLE | Application
Applications (App1)
Figure22 Data and Control Flow for CE220959
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e The BLE stack code can be executed by either CPU or by both CPUs; this is a selectable option in the BLE
Component configuration dialog. The code examples demonstrate this feature; in App0 the CM4 CPU
executes the BLE stack, in Appl the CM0O+ CPU executes the BLE stack.

e AppOand Appl enable different services in their BLE Component configurations:

- AppO0: Bootloader and Immediate Alert Service (IAS). The IAS service is implemented when the application
is not bootloading.

- Appl: Human Interface Device (HID) and Immediate Alert Service (IAS)
Both applications use the IAS to transfer control from one application to the other.

e The code examples make extensive use of CYS8CKIT-062-BLE PSoC 6 BLE Pioneer Kit resources. All three
RGB LEDs, the user button SW2, the BLE subsystem, and the USB-UART bridge are all used by both
applications (App0 and App1l).

To build the code examples, do the following. For more information on these steps, refer to PSoC 6 MCU Basic
Bootloaders or How to Use the SDK.

1. Create App0 and the workspace, as Figure 23 shows.
[ Create Project - CYBC6347BZ1-BLDS e e |

Create Project
Choose a name and location for your design.

Workspace name: My _BLE_Bootloader

Location: CAilzers\micea'\Desktop

Project name: appl

Figure 23 PSoC Creator Create BLE Bootloader App0

2. Add a BLE Component to the App0 Top Design schematic and configure the Component according to the
BLE Component Configuration section in either code example. Specifically, make the following changes
from the default configuration:

e (optional, but recommended to work with default Bootloader SDK files) Change the Component name to
‘BLE’.

e General tab (see Figure 24): CPU core: Single core (Complete Component on CM4)
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Name: BLE

" General | GATT Settings |~ GAP Settings |~ L2CAP Settings | Link Layer Settings |~ Advanced | Builtin | 4 [

[ Load configuration [ Save configuration

@ Complete BLE Protocol

Maxdmum number of BLE connections: |1 =
GAP role

Peripheral [] Broadcaster

7] Central 7] Observer

‘ CPU core: |Single core (Complete Component on CM4) hd ’

Over-The-Air bootloading with code sharing
@ Disabled

() Stack and Profile

() Profile only

() BLE Controller only (HCl over UART)

Figure 24 PSoC Creator BLE Component, General Tab Configuration

e GATT Settings tab (see Figure 25):
- Generic Access, Peripheral Preferred Connection Parameters:
1. Minimum Connection Interval: 0x000C
2. Maximum Connection Interval: 0x000C
3. Connection Supervision Timeout Multiplier: 0x00C8

These intervals are selected to minimize the bootloading time. Adjust as needed for your application.

- Right-click the Server node in the GATT tree, and add the Bootloader service. Optionally, add the
Immediate Alert service; the code examples use this service to transfer control between applications.
There is no need to edit either service’s characteristics.

- Attribute MTU size (bytes): 512
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" Configure 'BLE B
€3 Bluetooth'}|| "or- 8E
50 SMART [
-— 4 General '~ GATT Settings | GAP Settings | L2CAP Settings | Link Layer Settings |~ Advanced | Buitdn 4 B
Serverinstances: 1 | Client instances: 0 Characteristic:  Peripheral Pref 1 C P.
Add Descriptor ~ X |~ =~ UuID: 2A04
Tt = i T Length Val
BP GATT : ame ype Leng alue
[=] & Server = Fields y
-8 Generic Access Connection Interval wint’6 2 floxoooc
' Device Name - Maximum C Interval uintlé (2 I|DxD[JDC
Appearance
Peripheral Preferred Connection Parameters - Slave Latency uintlé |2 I|D
C Central Address Resolution - Connection Supervision Timeout Multiplier [uint16 |2 l| (x00C2
C) Resolvable Private Address Only El-P -
s G_'eneric Atribute =
E1-4C) Service Changed - Read |I‘u'|andatory
... (Client Characteristic Corfiguration [+}- Permissions
E-4S) B_ootloader
[E1-4€) Command
) D) Client Characteristic Corfiguration
El-5) Immediate Alert
A€ Mlert Level
Atribute MTU size bytes): (512 z
-

Figure 25 PSoC Creator BLE Component, GATT Settings Tab Configuration

e GAP Settings tab:
General, Device Name: The code examples use “BLE Bootloader”; use different text as needed for your

application.

Peripheral Configuration 0, Advertisement packet: Local Name checked and set to Complete.
Security configuration 0 (see Figure 26), Security level: Unauthenticated pairing with encryption.
Security configuration 0, I/O capabilities: No Input No Output.
Security configuration 0, Bonding requirement: No Bonding.

BLE

g Bluetﬂsnmi!!l' Name: ELE

5.0 4 General * GATT Settings .~ GAP Settings ] L2CAP Settings |~ Link Layer Settings -~ Advanced

Built-in

Add -,
‘# Security mode:

E| Peripheral configuration 0 Security level:

- Advertisement seftings 140 capabilties:
- Advertisement packet
Scan response packet
Security configuration 0

Restore Defaults
Datashest

Bonding requirement:

Mode 1

Unauthenticated pairing with encryption

[No Input Mo Output

No

No Bonding

Encryption key size bytes): (16 &

Figure 26 PSoC Creator BLE Component, GAP Settings Tab Configuration

e Link Layer Settings tab:
- Link layer max TX and RX payload size (bytes): 251, for faster bootloading
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3. For CE220959, add an SMIF Component to the App0 schematic, and configure the Component according to
the SMIF Component Configuration section. Specifically, make the following changes from the default
configuration:

e (optional, but recommended to work with CE220959 files) Name: SMIF

e Select SMIF Datalines [2:3]. The external memory IC has a quad-SPI (four data-line) interface with the
PSoC 6 MCU device. The SMIF Datalines [0:1] box is selected as a default.

e Unselect Generate code from cy_smif.cysmif file. Files cy_smif_memconfig.h/.c and smif_mem.h/.c are
already provided with the code example.

4. As needed, copy other Components - i.e., LEDs and button - from either the CE216767 or CE220959 top
design schematic to your top design schematic.

5. In the Design Wide Resources window:

e Pins tab: Connect the Component pins to the appropriate physical pins. Note that the BLE Component does
not use any pins.

e Clocks tab: Enable the WCO, and source Clk_LF and Clk_Bak from WCO. This required for operating the BLE
Component in certain modes; see the BLE Component datasheet for details.

- For CE220959, enable Clk_HF2 and set its frequency to 50 MHz. The easiest way to do this is to select the
divide by 2 option in the Clk_HF2 section. The frequency limit is required for correct operation of the
external memory interface.

6. Configure App0 as a bootloader in the project Build Settings - see Figure 10. Select BLE for the
communication channel.
7. Select Build > Generate Application. This creates the bootloader linker files, e.g., bootload_cm4.ld.

8. Go back to the project Build Settings and set the Custom Linker Script for CMO+ and CM4 to the respective
bootloader linker script files - see Figure 12.

9. Edit the flash and RAM memory region sizes in bootload_common. ld, as follows:

MEMORY

{ ( )
flash appO0 corel (rx) : ORIGIN =] 0x10000000, LENGTH = 0x10000
flash appO0 corel (rx) : ORIGIN =] 0x10010000, LENGTH = 0x30000
flash appl core0 (rx) : ORIGIN =|0x10040000, LENGTH = 0x32000
flash appl corel (rx) : ORIGIN =|0x10072000, LENGTH = 0x02000
ram app0 corel (rwx) : ORIGIN =] 0x08000100, LENGTH = 0x1FO0O
ram app0 corel (rwx) : ORIGIN =] 0x08002000, LENGTH = 0x8000
ram _appl core0 (rwx) : ORIGIN =] 0x08000100, LENGTH = O0x1FFO0O
ram appl corel (rwx) : ORIGIN =LQXO8O2OOOO, LENGTH = 0x20000 )

The default bootload_common. ld allocates an equal amount of flash and RAM to each CPU in each application.
The allocations must be adjusted for these code examples because:

e TheBLE stacksizeis large
e Applsize should be minimized to reduce bootloading time

Note that the same changes are done for Appl in the code examples. Similar memory layouts exist for the MDK
and IAR linker scripts.
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10. Copy and paste files debug.h/.c, ias.h/.c, and
bootload_user.h/.c from your CE216767 or
CE220959 folder to your app0.cydsn folder.
Overwrite the existing default
bootload_user.h/.c files. In addition, for
CE220959, copy and paste
cy_smif_memconfig.h/.c and smif_mem.h/.c
files.

e The debugand ias (Immediate Alert Service)
files are unique to the code examples and may
be optional for your application.

e The bootload_user files have already been
edited to call the BLE transport functions
instead of the default UART transport
functions.

e For CE220959, the SMIF files define the external
memory configuration and provide functions to
access external memory.

11. In the PSoC Creator Workspace Explorer
window, include or move the files from the
previous step to the project CM4 Header Files

and Source Files folders, as Figure 27 shows.

If these files are in the Shared Files folder, they

may be included in the CMO+ build and compile

errors may result.

Copy CM0+ and CM4 main code from CE216767

or CE220959 to your main files. Update the

main and other source files as needed for your

application.

Build app0, and program the kit with app0.

You can test your app0 by installing app1 from

CE216767 or CE220959. Follow the instructions

in the code example document, Operation

section.

16. If you build your own appl, remember to edit
the following files:

12.

13.

14.
15.

Application Note

e Three linker script files as described in Step 9
and in Section 4.3.2 Step 6.

e The batch file as described in Section 4.3.2
Step 8.

Workspace Explorer (1 project]
&3

[es]| Workspace 'My_BLE_Bootloader' (1 Projects) =
E}El Project "app0’ [CYBC6347BZ1-BLD53]

W
,ir TopDesign.cysch E'
_'P Design Wide Resources (appl.cydwr) &
-5 CMOp (Core 0 5
€] o) [
-\.j ARM GCC Generic %
D ARM IAR Generic =

&HED) ARM MDK Generic
E}_} Header Files E
. -] cy_smif_memcenfig.h %
-[n] debug.h i
- h] ias.h =)

ﬂ =mif_mem.h

- 1] transport_ble.h ﬁ
E}_} Source Files %

FH) ARM GCC Generic
FH) ARM TAR Generic
FHD ARM MDK Generic
-|¢] bootload_user.c
E] cy_smif_memconfig.c
-|¢] debug.c

-|€] ias.c

€] main_cmd.c

€] sif_menm.c

m

-|g] system_psoc63_cmd.c
-|¢] transport_ble.c

EHC) Shared Files

EHED ARM GCC Generic

53 ARM TAR Generic

&HED ARM MDK Generic

. >ﬂ bootload_user.h )
i 0l v ble confiah

Source Files Included in PSoC
Creator CM4 Folders

Figure 27
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5.3.1 BLE Bootloader with Upgradeable Stack

This code example is different from the other BLE
bootloader code examples in that it has three
applications, as Figure 28 shows.

Launcher (App0)

In this example App0 does not do bootloading; it is
solely a launcher application. It also copies a stack
update from a temporary location to the proper

Stack and Bootloader
Application (Appl)

Bootloading
Utility

location and starts either the stack or the user BLE [e—

application. App0 cannot be updated by OTA

bootloading. BLE y
Applications User Application

Appl is the stack application. It contains the (App2)

bootloader and the BLE stack. The bootloader can
download an update to the user application or to
the stack. Updating the stack requires placing the
update in a temporary location and switching to
the launcher for copying, because the stack cannot
overwrite itself.

Figure 28 Data and Control Flow for
CE220960

App2 is the user application. It has a PSoC Creator BLE Component, but it contains only profiles without the
supporting stack code. Required stack code and variables are shared from the stack application, considerably
reducing the size of the user application.

The steps to build this code example are similar to those for the other BLE code examples; the main
differences are that you create three projects, and the BLE configurations are different:

e Create App0 and the workspace, as Figure 23 shows.

e Asneeded, copy Components -i.e., LEDs and button - from the CE220960 App0 top design schematic to
your top design schematic.

e Inthe Design Wide Resources window, Pins tab, connect the Component pins to the appropriate physical
pins. Use CE220960 and the guide for your kit for instructions.

e Configure App0 as a bootloader in the project Build Settings - see Figure 10. You must do this to enable
the copy application and transfer control functions - select only the Core and App type boxes. Do not
select any of the communication channel boxes.

e Select Build > Generate Application. This creates a number of files, including the bootloader linker files,
e.g., bootload_cm4. [d.

e Go back to the project Build Settings and set the Custom Linker Script for CM0+ and CM4 to the
respective bootloader linker script files; see Figure 12. Also, add to the CM4 User Commands a call to the
post_build_corel.bat file; see Figure 13.

e Update thefiles, and copy the new files, listed in Table 5 from the corresponding files in CE220960. Add
code as needed for your application.
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Table5 CE220960 PSoC Creator AppO Files Modified from the Bootloader SDK Default
File Description of Modification from the Default
bootload_common.ld, bootload_cmOp.ld, Modified memory allocations for the three
bootload_cmA4.ld applications

bootload_mdk_common.h,
bootload_mdk_symbols.c

bootload_cmOp.scat, bootload_cm4.scat

bootload_user.h, bootload_user.c Modified number of applications in metadata
main_cmOp.c, main_cm4.c Addition of code to do the code example
functions

New Files; copy from the code example, and add to the Shared Files folder

post_build_corel.bat Copies output to a build location for Appl and
App2

. Add a new project App1 to the workspace. Add Components and files to the project, and configure it, in the
same manner as App0 in the other BLE code examples; except in the BLE configuration dialog, select
Stack and Profile for Over-The-Air bootloading with code sharing.

. Use CE220960 App1 for guidance. Note that in CE220960 App1 has two post-build batch files, one for each
core.

. Test using the instructions in CE220960.

e Addanew project App2 to the workspace. Add Components and files to App2, and configure it, in the same

manner as App0 in the other BLE code examples, except in the BLE configuration dialog, select Profile
Only for Over-The-Air bootloading with code sharing. Use CE220960 App2 for guidance.

5.4 PSoC 6 MCU Dual-Application Bootloader

This section shows how to build the BLE bootloader in the code example CE221984. This code example is like
the basic bootloaders code example, except that there are two downloadable applications instead of one.
There are three applications; App0 is the bootloader and Appl and App2 are the downloadable applications.

The bootloader transfers control to one of the applications in either a basic mode or a factory default (“golden
image”) mode. In factory default mode, the bootloader (App0) does not overwrite an installed and valid App1;
an attempt to do so results in an error message. In basic mode, either application can be overwritten.

In this code example, the bootloader uses an I?C communication channel. Changing to a different
communication channel is simple; for more information, refer to one of the previous sections.

To build this code example, do the following steps. For more information on these steps, refer to PSoC 6 MCU
Basic Bootloaders or How to Use the SDK.
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1. Create App0 and the workspace, as Figure 29 shows.

Create Project - CYBC6347BZLBLDS E——

Create Project
Choose a name and location for your design.

Workzpace name: MyDualAppBootloader

Location: Chilzers‘mikeaDesktop

Project name: appl

Figure 29 PSoC Creator Create Dual-Application Bootloader App0

2. Configure App0 as a bootloader in the project Build Settings; see Figure 10. Select 12C for the
communication channel.

3. Select Build > Generate Application. This creates the bootloader linker files, e.g., bootload_cmA4.1d.

4. Go back to the project Build Settings and set the Custom Linker Script for CM0+ and CM4 to the respective
bootloader linker script files - see Figure 12.

5. Add an12C Component to the App0 schematic and configure the Component according to Figure 18. At
this time, you can also add the Pin Components used by CE221984; the easiest way to do this is to copy
and paste the Components from the code example schematic.

6. Inthe Design-Wide Resources window, Pins tab, connect the Component pins to the appropriate physical
pins.

7. Update thefiles listed in Table 6 with the content of the corresponding files in CE221984. Add code as
needed for your application.

Table 6 CE221984 AppO Files Modified from the Bootloader SDK Default
File Description of Modification from the Default
bootload_common. ld Addition of memory regions for App2
bootload_mdk_common.h
bootload_user.h Set the CY_BOOTLOAD_GOLDEN_IMAGE_IDS macro to identify Appl as

the factory default image.

To change the code example mode, change the
CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro to a nonzero value.

bootload_user.c Changed transport functions to I°C from UART.
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File Description of Modification from the Default

Added code to Cy_Bootload_WriteData () todo the factory default
(“golden image”) check.

main_cmOp.c Addition of code to do the code example functions

main_cm4.c

8. Build the app0 project, and program it into the target kit. Test the application download (bootload)
process. You can use the test steps listed in the Operation section of the CE221984 document. Try
changing the CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro to a nonzero value and note the different
behavior of the bootloader when you download Appl.

You can test the bootloader using the appl and app2 projects already in the code example, or create your
own applications, as the following step shows:

9. Add anappl project and an app2 project. You can configure both projects as installable applications. The
detailed steps required are presented in Section 5.2.2 Step 3 and Step 4. Significant tasks are:

e Update the project build settings:
- Peripheral Driver Library > Bootloader SDK. Select only the Core box. (Figure 10)
- Linker custom scripts. (Figure 12)
- Post-build batch file (Figure 13)

e Add the post_build_corel.bat file to the project, in the Shared Files folder. See Appendix E for typical batch
file content.

e Update the project schematic and design-wide resources files with the content of the corresponding files
in CE221984. Modify the design as needed for your application.

e Update thefiles listed in Table 7 with the content of the corresponding files in CE221984. Add code as
needed for your application.

Table 7 CE221984 PSoC Creator App1 and App2 Files Modified from the Bootloader SDK Default
File Description of Modification from the Default
bootload_common. Id Addition of memory regions for App2

bootload_mdk_common.h

bootload_cmp0.ld Specify the memory regions and App ID as being for app1 or app2
bootload _cm4.ld
bootload_cmp0.scat
bootload_cm4.scat
bootload_user.h Set the CY_BOOTLOAD_GOLDEN_IMAGE_IDS macro to identify Appl as

the factory default image; to change the code example mode, change the
CY_BOOTLOAD_OPT_GOLDEN_IMAGE macro to a nonzero value

main_cmOp.c Addition of code to do the code example functions
main_cm4.c
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5.5 PSoC 6 MCU Encrypted Bootloader

This section shows how to build a bootloading system with security features, as demonstrated in the code
example CE222802. This code example is similar to the basic bootloaders code example, with additional
features - signing and encryption - needed for secure bootloading. App0 is the bootloader; the downloadable
Appl can be signed, encrypted, or both.

In this code example, the bootloader uses a UART communication channel. Changing to a different
communication channel is simple; for more information, refer to one of the previous sections.

To build this code example, do the following steps. For more information on these steps, refer to PSoC 6 MCU
Basic Bootloaders or How to Use the SDK.

Note: Signing and encryption require keys. Files containing default keys are provided in the code
example, but for your applications you will want to create new keys. The code example supports creating new keys,
but to do so you must first install OpenSSL and Python in your computer. See the code example document for
details.

1.  Create App0 and the workspace, as Figure 30 shows.

5/1-BLDS

Create Project

Choose a name and location for your design.

Workspace name: MyEncrptedBootloader

Location: CiUsers'mhkeaDesktop

Project name: app(|

Figure 30 PSoC Creator Create Encrypted Bootloader App0

2. Configure App0 as a bootloader in the project Build Settings; see Figure 10. Select UART for the
communication channel.

3. Alsoin the Build Settings, select Peripheral Driver Library > PDL > crypto, and under Variant select Extra
library to enable support for AES decryption.
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4. Select Build > Generate Application. This creates the bootloader linker files, e.g., bootload_cm4.ld.

5. Go back to the project Build Settings and set the Custom Linker Script for CMO+ and CM4 to the respective
bootloader linker script files; see Figure 12. Also, add to the CM4 User Commands a call to the
post_build_corel.bat file; see Figure 13.

6. Add a UART Component to the App0 schematic and configure the Component according to Figure 18. At
this time, you can also add the Pin Components used by CE222802; the easiest way to do this is to copy
and paste the Components from the code example schematic.

7. Inthe Design-Wide Resources window, Pins tab, connect the Component pins to the appropriate physical
pins. Use CE222802 and the guide for your kit for instruction.

8. Update the files, and copy the new files, listed inTable 8 from the corresponding files in CE222802. Add
code as needed for your application.

Table 8 CE222802 AppO Files Modified from the Bootloader SDK Default
File Description of Modification from the Default
bootload_common.ld Different signature size
bootload_mdk_common.h
bootload_user.h Set #defines to enable the crypto block and secure verification
bootload_user.c Addition of key variables and decrypt function
main_cmop.c Addition of code to do the code example functions
main_cm4.c

New Files; copy from the code example, and add to the Shared Files folder

cy_si_config.h Key storage
cy_si_keystorage.h, .c

post_build_corel.bat Signs and encrypts the output file

9. Copy from CE222802 the project folder CE222802_Keys.cylib into your workspace folder. This folder
contains key files that are used by post_build_corel.bat. You can replace these keys with your own keys;
see the code example document for instructions.

10. The folder also contains a PSoC Creator library project file CE222802_Keys.cylib. You can optionally add
this library project to your workspace.

11. Build the app0 project, and program it into the target kit. Test the application download (bootload)
process. You can use the test steps listed in the Operation section of the code example document.

Note: The bootloader project is built in a format such that it is validated by a Flash Boot module in
PSoC 6 MCU supervisory flash (Sflash), as part of device initialization. If you reprogram the device
to replace app0 with another project, validation will fail and the device will not boot. If you want
to reprogram the device with other projects, you must first disable validation of app0 and then
reprogram it into the device - see the instructions in the code example document.

You can test the bootloader using the app1 project already in the code example, or create your own

application, as the following step shows:
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12.Add an app1l project. You can configure is as an installable application. The detailed steps required are

presented in Section 5.2.2 Step 3 and Step 4. Significant tasks are:
e Update the project build settings:
- Peripheral Driver Library > Bootloader SDK. Select only the Core box. (Figure 10)
- Linker custom scripts. (Figure 12)
- Post-build batch file (Figure 13)

e Update the project schematic and design-wide resources files with the content of the corresponding files

in CE222802. Modify the design as needed for your application.

e Update the files, and copy the new files, listed in Table 9 from the corresponding files in CE222802. Add

code as needed for your application.

Table9 CE221984 App1 Files Modified from the Bootloader SDK Default

File

Description of Modification from the Default

bootload _common.ld
bootload_mdk_common.h

Specify memory regions

bootload_cmp0.ld
bootload_cmA4.ld
bootload_cmp0.scat
bootload_cm4.scat

Specify memory regions and App ID

bootload _user.h

Set #defines to enable the crypto block and secure verification

main_cmOp.c
main_cm4.c

Addition of code to do the code example functions

New Files; copy from the code example, and add to the Shared Files folder

cy_si_config.h

Key storage

post_build_corel.bat

Signs and encrypts the output file

Application Note

002-13924 Rev. *G
2021-03-31


http://www.cypress.com/ce222802

PSoC 6 MCU Device Firmware Update Software Development Kit
Guide

(infineon

DFU Host Tool

6 Related Documents

For a comprehensive list of PSoC 6 MCU resources, see KBA223067 in the Cypress community.

Application Notes

AN221774 - Getting Started with PSoC 6 MCU

Describes PSoC 6 MCU devices and how to build your
first ModusToolbox or PSoC Creator project

AN210781 - Getting Started with PSoC 6 MCU
with Bluetooth Low Energy (BLE) Connectivity

Describes PSoC 6 MCU with BLE Connectivity devices
and how to build your first PSoC Creator project

AN215656 - PSoC 6 MCU: Dual-CPU System
Design

Describes the dual-CPU architecture in PSoC 6 MCU,
and shows how to build a simple dual-CPU design

AN219434 - Importing PSoC Creator Code
into an IDE for a PSoC 6 MCU Project

Describes how to import the code generated by PSoC
Creator into your preferred IDE

Code Examples

CE213903 - PSoC 6 MCU Basic DFU

Describes UART, I°C, and SPI DFU for PSoC 6 MCU

CE216767 - PSoC 6 MCU with Bluetooth Low
Energy (BLE) Connectivity Bootloader

Describes a BLE bootloader for PSoC 6 MCU

CE220959 - PSoC 6 MCU BLE Bootloader with
External Memory

Similar to the BLE bootloader; the downloaded
application is temporarily saved in external memory
and then copied to its final destination

CE220960 - PSoC 6 MCU BLE Bootloader with
Upgradeable Stack

Similar to the BLE bootloader; the BLE stack can be
updated in addition to the application

CE221984 - PSoC 6 MCU Dual-Application 12C
Bootloader

Similar to the basic I°C bootloader; manages two
downloaded applications instead of one

CE222802 - PSoC 6 MCU Encrypted
Bootloader

Similar to the basic UART bootloader; the application is
digitally signed and encrypted

PSoC Creator Component Datasheets

UART

Supports UART-based communications

12C Supports I*C-based communications
SPI Supports SPI-based communications
BLE Supports BLE communications

Device Documentation

PSoC 6 MCU: PSoC 63 with BLE Datasheet

PSoC 6 MCU: PSoC 63 with BLE Architecture
Technical Reference Manual

Development Kit Documentation

CY8CKIT-062-BLE

PSoC 6 BLE Pioneer Kit

CY8CKIT-062-WiFi-BT

PSoC 6 WiFi-BT Pioneer Kit
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CYS8CPROTO-063-BLE PSoC 6 BLE Prototyping Kit
CYS8CPROTO-062-4343W PSoC 6 Wi-Fi Prototyping Kit

Tool Documentation

ModusToolbox IDE simplifies development for loT
designers. It delivers easy-to-use tools and a familiar

ModusToolbox microcontroller (MCU) integrated development
environment (IDE) for Windows, macQS, and Linux.
PSoC Creator enables concurrent hardware and
firmware editing, compiling and debugging of PSoC

PSoC Creator devices. Applications are created using schematic

capture and over 150 pre-verified, production-ready
peripheral Components. Look in the downloads tab for
Quick Start and User Guides.

Installed by PSoC Creator 4.2. Look in the <PDL install
folder>/doc for the User Guide and the API Reference

Peripheral Driver Library (PDL)
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Appendix A. DFU Host Tool

The DFU Host Tool (DHT) is a standalone graphical tool provided with ModusToolbox IDE. (There is also a
Bootloader Host Program (BHP) provided with PSoC Creator. It operates much the same as DHT.) This tool is
used to communicate with a PSoC device that has DFU installed. Using this tool, you can:

e Download and install an application to a device
o Verify an application that is already installed on a device
e Erase an application from a device

Note: You cannot use DHT to install a DFU application into a device. Instead, you must program it
through the device SWD/JTAG port, using other tools such as ModusToolbox IDE or Cypress
Programmer. After a DFU application is installed, you can use DHT to install a downloadable
application.

DHT supports communicating with Cypress MCU devices via UART, I°C, SPI, or USB, as Error! Reference s
ource not found.shows. You can see all devices available for connection. For UART or USB, communication
can be done directly from your computer by connecting an appropriate cable. For I’C and SPI, a special
communication port is needed, such as a KitProg module. The port configuration fields change depending on
the selected port.

Note:
13.At this time, only the UART, I°C, and SPI-based DFU are supported for PSoC 6 MCU.

4. DHT does not support Bluetooth Low-Energy (BLE). Use Cypress’ CySmart product instead; see the CySmart
User Guide section “Updating Peripheral Device Firmware”.

84 Device Firmware Update Host Toc

File Actions Help

B d

File: C:/Users/mkea/mtw —teﬁ'PSoCGDqupp 1_mainapp,/Debug/PSoCaDfulppl_mainapp_dfu.cyacd2 ) B

Ports: Filters...
or =k Baud:  [115200 ¥

Intel(R) Active Management Technelogy - SOL (COM3) - UART Data bits:
KitProg3-0B210E1701217400 - [2C -

KitProg3-0B210E1701217400 - SPI Stop bits:
KitProg3 USB-UART (COMB6) - UART ity

Log:

2018-11-16 10:43:08,491 Program started,
2018-11-16 10:43:51.633 Operation took 43141 miliseconds.
2018-11-16 10:43:51.633 Operation succeeded.

Figure 31 DFU Host Program Graphical User Interface (GUI)
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Appendix B. Host Command/Response Protocol

The DFU module communicates with a host using a simple command-response protocol, regardless of the
communication channel used. The DFU module receives commands from the communication channel and
responds to each command by sending one or more bytes to the communication channel. See Figure 2.

The commands and responses are in the form of a byte stream, packetized in a manner that ensures the
integrity of the data being transmitted. A packet validity check method is included and consists of a 2's
complement 16-bit checksum.

B.1 Command/Response Packet Structure

Communication packets sent from the host to the DFU module have the structure shown in Figure 32:

Start of Packet Command Data Length (N) | N bytes of data Checksum End of Packet
(0x01) (0x17)

«—1 Byte——»<«——1 Byte——>»<«——2 Bytes—»<«——N Bytes——»<«—2 Bytes——>»<«——1 Byte—>»

Figure 32 DFU Command Packet Structure

Response packets sent from the DFU module to the host have the structure shown in Figure 33:

Start of Packet Status Code Data Length (N) | N bytes of data Checksum End of Packet
(0x01) (0x17)

«——1 Byte——>»<«——1 Byte——>»<«——2 Bytes—>»<«——N Bytes——»<«—2 Bytes——>»<«——1 Byte—>»

Figure 33 DFU Response Packet Structure

All multi-byte fields are LSB first.

B.2 Commands

Table 10 shows a list of all commands supported by the DFU SDK. All commands except Exit DFU are ignored
until the Enter DFU command is received.

Table 10 DFU Commands List
DFU Commands
Enter/Exit DFU Operation Miscellaneous
Enter DFU Send Data Verify Application
Application Note 50 of 66 002-13924 Rev. *G

2021-03-31



PSoC 6 MCU Device Firmware Update Software Development Kit o,
Guide (Infineon

Host Command/Response Protocol

DFU Commands

Enter/Exit DFU Operation Miscellaneous

Sync DFU Send Data Without Set Application Metadata
Response

Exit DFU Program Data Get Metadata
Verify Data Set EIVector
Erase Data

There is no specific requirement for command execution time.

Table 11 shows a list of all status and error codes supported by the DFU SDK.

Table 11 DFU Status and Error Codes List
Status/Error Code Value | Description
CY_DFU _SUCCESS 0x00 | The command was successfully received and executed
CY_DFU _ERROR_VERIFY 0x02 | Verification of non-volatile memory (NVM) after writing failed
CY_DFU _ERROR_LENGTH 0x03 | The amount of data sent is greater than expected
CY_DFU _ERROR_DATA 0x04 | Packet datais not of the proper form
CY_DFU _ERROR_CMD 0x05 | The command is not recognized
CY_DFU _ ERROR_CHECKSUM 0x08 | Packet checksum or CRC does not match the expected value
CY_DFU _ ERROR_ROW 0xOA | The flash row number is not valid
CY_DFU _ERROR_ROW_ACCESS | 0x0OB | The flash row number cannot be accessed, for example due to
MPU protection
CY_DFU _ERROR_UNKNOWN 0xOF | An unknown error occurred
B.2.1 Enter DFU

Begins a DFU operation. All other commands except Exit DFU are ignored until this command is received.
Responds with device information and DFU SDK version.
e Input

- Command Byte: 0x38

- Data Bytes:

» 4 bytes (optional): product ID. If these bytes are included, and they are not 00 00 00 00, they are
compared to device product ID data.

e Output
- Status/Error Codes:
= Success
= Error Command
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= Error Data, used for product ID mismatch
= Error Length
= Error Checksum

- Data Bytes:

4 bytes: Device JTAG ID

1 byte: Device revision

3 bytes: DFU SDK version

B.2.2 Sync DFU

Resets the DFU to a known state, making it ready to accept a new command. Any data that was buffered is
discarded. This command is needed only if the DFU module and the host get out of sync with each other.

e Input
- Command Byte: 0x35
- Data Bytes: N/A
e Output: N/A - this command is not acknowledged

B.2.3 Exit DFU
Exits from the DFU. Ends the DFU operation.

e Input
- Command Byte: 0x3B
- Data Bytes: N/A
e Output: N/A - This command is not acknowledged

B.2.4 Send Data

Transfers a block of data to the DFU module. This data is buffered in anticipation of a Program Data or Verify
Data command. If a sequence of multiple send data commands are sent, the data is appended to the previous
block. This command is used to break up large data transfers into smaller pieces, to prevent channel
starvation in some communication protocols.

e Input
- Command Byte: 0x37
- Data Bytes:
» nbytes: Data to write or verify
e Output
- Status/Error Codes:
= Success
= Error Command
= Error Data
= ErrorLength
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= Error Checksum
- Data Bytes: N/A

B.2.5 Send Data Without Response

Same as the Send Data command, except that no response is generated by the DFU module. This reduces DFU
time for some applications.

e Input
- Command Byte: 0x47
- Data Bytes:
* n bytes: Data to write or verify
e Output: N/A

B.2.6 Program Data

Writes data to one row of the device internal flash or page of external nonvolatile memory (NVM). May follow a
series of Send Data or Send Data Without Response commands.

e Input
- Command Byte: 0x49
- Data Bytes:

= 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to
external memory alignment requirements.

= 4 bytes: CRC-32C of the entire data to be written. The data is verified both before and after
programming.
» nbytes: Data to write into the flash row or external NVM page.
e Output
- Status/Error Codes:
= Success
* Error Command
= ErrorData
= Error Length
» Error Checksum
= Error Flash Row
= Error Flash Row Access
- Data Bytes: N/A
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B.2.7 Verify Data

Compares data to one row of the device internal flash or page of SMIF. May follow a series of Send Data or
Send Data Without Response commands.

This command is optional; its presence depends on a user configuration macro in dfu_user.h.

e Input
- Command Byte: 0x4A
- Data Bytes:

= 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to
external memory alignment requirements.

» 4 bytes: CRC-32C of the entire data to be verified.
= nbytes: Data to compare with the flash row or SMIF page.
e Output
- Status/Error Codes:
= Success
= Error Verify
= Error Command
= ErrorData
= Error Length
» Error Checksum
= Error Flash Row
» Error Flash Row Access
- Data Bytes: N/A
¢ Implementation details

- The command returns the “Success” status code if all data bytes match the bytes starting at the
specified flash address, otherwise “Error Verify”.

B.2.8 Erase Data

Erases the contents of the specified internal flash row or SMIF page.
This command is optional; its presence depends on a user configuration macro in dfu_user.h.

e Input
- Command Byte: 0x44
- Data Bytes:

= 4 bytes: Address. Must be within the correct memory address space, and appropriately aligned. For
internal flash, it must be aligned to a flash row boundary. For external memory, it must conform to
external memory alignment requirements.
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e Output
- Status/Error Codes:
= Success
= Error Command
= ErrorData
= Error Length
= Error Checksum
= Error Flash Row
= Error Flash Row Access
- Data Bytes: N/A

B.2.9 Verify Application
Reports whether the checksum for the application in flash or external NVM is valid.

e Input
- Command Byte: 0x31
- Data Bytes:

= 1 byte: Application number of the application to be verified. May range from 0 to the number of
applications minus one.

e Output

- Status/Error Codes:
= Success
* Error Command
= ErrorData
= Error Length
» Error Checksum
» Error Flash Row Access

— Data Bytes:
= 1 byte: 1/0 for application is valid or not valid

B.2.10 Set Application Metadata

This command is used to set a given application’s metadata. See Appendix D, Application Metadata.

Note: This command does not update the metadata if the user configures the DFU SDK to keep the
metadata unchanged.

e Input
- Command Byte: 0x4C
- Data Bytes:
= 1 byte: Application #
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= 8 bytes: metadata field format per Appendix D
e Output
- Status/Error Codes:
= Success
* Error Command
= Error Length
= ErrorData
= Error Checksum
= Error Flash Row Access
- Data Bytes: N/A

B.2.11 Get Metadata

Reports selected metadata bytes.
This command is optional; its presence depends on a user configuration macro in dfu_user.h.

e Input
- Command Byte: 0x3C
- Data Bytes:
= 2 bytes: from offset within row; 0 - 511
= 2 bytes: to offset within row; 0 - 511 (inclusive)
e Output
- Status/Error Codes:
= Success
= Error Command
= Error Length
= Error Data
= Error Checksum
= Error Flash Row Access
- Data Bytes:
= N bytes - per from and to offset bytes (inclusive)

B.2.12 Set ElVector

Sets an encryption initialization vector (EIV). This enables the DFU module to decrypt data before writing it to
flash.

This command is optional; its presence depends on a user configuration macro in dfu_user.h.

e Input
- Command Byte: 0x4D
- Data Bytes:
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= n bytes: the vector; 0, 8, or 16 bytes, little-endian raw data
e Output
- Status/Error Codes:
= Success
* Error Command
= Error Length
= ErrorData
= Error Checksum
- Data Bytes: N/A
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.cyacd2 File Format
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The .cyacd?2 file contains downloadable application data. It is created by CyMCUEIfTool, and used by host

programs such as Cypress’ DFU Host Program and CySmart to send applications to the target DFU module,
as Figure 5 shows. The file data is in the form of ASCII hex numbers, similar to Intel hex format. Each byte of
datais represented by two characters. For example, a byte 0x1E is represented by the characters 0x31 (ASCII
‘1’) followed 0x45 (ASCII ‘E’).

All multi-byte fields are little-endian.

The file consists of a series of lines, or rows. Each row is terminated with ASCII CR, LF characters. A row is one
of the following types:

e Encryption initial vector: An encryption initial vector row is of the format @EIV:<bytes>. The datain
<bytes> is used by the host program in the SetEIV command to the DFU module.

e Application verification information: An application verification information row is of the format:
e @APPINFO:[__cy app_verify start],[__cy app_verify length].

e Thestart and length data are used by the host program in the Set Application Metadata command to the
DFU module.

e Header: A header row has the structure shown in Table 12.

Table 12 cyacd2 Header Row Structure
File Version Silicon ID | Silicon Revision | Checksum Type | AppID Product ID
1 byte 4 bytes 1 byte 1 byte 1 byte 4 Bytes

- File Version: Numbered starting at 1.

- Silicon ID, Silicon Revision, Product ID: Used to prevent the application from being downloaded to the
wrong device.

- Checksum Type: The method used to verify a DFU packet (see Appendix B, Command / Response
Packet Structure). 0 = checksum, 1 =CRC.

- App ID: See Figure 6. This also controls which portion of the application metadata is updated for this
application.

e Data: Adatarow has the structure shown in Table 13.

The value of N equals the total amount of data to be sent
with a series of Send Data or Send Data Without Response
commands followed by a Program Data or Verify Data

command.

“,»
.

Table 13 cyacd2 Data Row Structure
Header Address Data
1 character: 4 bytes N bytes

The value of N typically, but not necessarily, equals the
length of an NVM row. For example, if downoading into RAM,
then N may be an arbitrary value.
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Appendix D. Application Metadata

The DFU SDK uses a designated region of NVM (or RAM in some cases) to store information about the
applications - see Figure 6. Metadata information is generally used for the following purposes:

e Validate an application

e Transfer control from one application to another

e Copy an application image from a temporary location to its designated location

As noted in Figure 6, metadata typically occupies one flash row or NVM page. (In devices with small amounts

of flash, multiple rows or pages may be used.) Figure 6 also shows that metadata is located outside of any
application.

Table 14 contains symbols that are used to define the location, size and usage of the DFU metadata. The
symbols are defined in the SDK linker script files and C source files.

Note: All examples shown are for the GCC compiler and linker. Similar statements exist in source and
linker script files for the MDK and IAR compilers and linkers.

Table 14 Metadata-Related Symbols
Symbol Defined In Purpose
flash_boot_meta dfu_cmOp.ld, Defines the physical memory region that contains
dfu_cm4.ld the metadata

Example Usage: f1ash boot meta (rw) : ORIGIN = 0x100FFA00, LENGTH = 0x400
Defines a region in the last 1 KB of the 1-MB PSoC 6 MCU user flash (which starts at 0x1000 0000).

__cy_boot metadata_addr dfu_cmOp.ld, These symbols define a compiler-independent
__cy_boot_metadata_length dfu_cm4.ld memory address range that is used to store the
metadata. These symbols are used in the DFU
SDK code and may be used in user code.

Example Usage: /* Bootloader SDK metadata limits */
/* Note that @ cy memory O row size equals the row length in
bytes of
PSoC 6 user flash. */
__cy boot metadata addr = ORIGIN (flash boot meta);
__cy boot metadata length = cy memory 0 row size;
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Symbol Defined In Purpose
.cy_boot_metadata dfu_cmOp.ld, The DFU metadata is stored in this section. At
dfu_cm4.ld build time, CyMCUEIfTool calculates the

checksum of this section and places it in the last
four bytes of the section. When a checksum is not
needed, rename the section to any other name.

Example Usage: cy boot metadata
{
KEEP (* (.cy _boot metadata))
} > flash boot meta

CY_DFU_MAX_APPS dfu_user.h Allows the user to control the maximum number
of applications supported in the DFU metadata

Example Usage: /* The smallest metadata size is CY DFU MAX APPS * 8 bytes
per app +
an optional 4 bytes for metadata checksum */
#define CY DFU MAX APPS (2u)

CY_DFU_METADATA WRITABLE dfu_user.h The DFU does not necessarily write metadata - it
can be done by the application or some other
user code. Or metadata may be set using a
compile-time constant within an application. An
application can have metadata that is smaller
than an NVM row.

In all these cases, set this macro to 0 to prevent
the DFU from writing metadata.

However, note that the DFU requires that a
metadata region exist and be properly initialized.
This may be done by the DFU itself, or by an
application.

Example Usage: /* A non-zero value allows writing metadata with the
SetAppMetadata command. */
#define CY DFU METADATA WRITABLE (1)
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Application metadata has eight bytes of data per application, followed by four bytes for checksum, as

Table 15 shows:

Table 15 Metadata Structure

Application 0 Application
1

8 bytes IEL

ApplicationN-1 | Checksum

8 bytes

4 bytes

Application Start

Address

Application Length
(bytes)

4 bytes

4 bytes

You can set the number of applications N in the dfu_user.hfile:

#define CY DFU MAX APPS (N)

The default value of N is 2.

Each application start address must be aligned to a flash row or NVM page boundary. The application length
must be a multiple of the flash row or NVM page length.

The Checksum is calculated with the same algorithm that is used in the DFU commands Program Data and
Verify Data. The default algorithm is CRC-32C.
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Appendix F.  Post-Build File Listings

The following are listings of the post-build bash and batch files for App1, from CE213903. The files are similar if
not the same in the other code examples. The same bash/batch can be used with multiple downloadable
applications, for example app2 in the dual-application bootloader.

F.1 ModusToolbox Post-Build Bash File
#!/bin/bash

A R R R R R

# This script is designed to post process a PSoC 6 application. It performs
sign and merge.

#

# usage:

#  dfu postbuild.bash <MCUELFTOOL LOC> <CMOP LOC> <CM4 LOC> <MCU CORE>

#

FHEFHH A AR A A HA AR AR AR A H AR R 1 4

MCUELFTOOL LOC=$1
CMOP LOC=$2
CM4 LOC=$3
MCU CORE=$4

echo Script: cymcuelftool postbuild
echo 1: MCUELFTOOL LOC : SMCUELFTOOL LOC

echo 2: CMOP_LOC : SCMOP_LOC
echo 3: CM4 LOC : SCM4 _LOC
echo 4: MCU_CORE : SMCU_CORE
echo

filenameNoExt cmOp="${CMOP LOC%.*}"
filenameNoExt cm4="${CM4 LOCS%.*}"

if [ "SMCU CORE" == "ARM CM4" ]; then
SMCUELFTOOL LOC --sign $CM4 LOC --output $filenameNoExt cm4" signed.elf"

SMCUELFTOOL LOC --merge $filenameNoExt cm4" signed.elf"
$filenameNoExt cmOp" signed.elf" --output SfilenameNoExt cm4" final.elf"

#DFU

SMCUELFTOOL LOC --sign $filenameNoExt cm4" final.elf" CRC --output
$filenameNoExt cm4" dfu.elf"
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SMCUELFTOOL LOC -P $filenameNoExt cm4" dfu.elf" --output
$filenameNoExt cm4" dfu.cyacd2"

else
SMCUELFTOOL LOC --sign $CMOP LOC --output S$filenameNoExt cmOp" signed.elf"
if [ -e $filenameNoExt_cm4"_signed.elf" 1; then

SMCUELFTOOL LOC --merge $filenameNoExt cm4" signed.elf"
$filenameNoExt cmOp" signed.elf" --output $filenameNoExt cm4" final.elf"

fi
fi

F.2 PSoC Creator Post-Build Batch File
@rem Usage:
@rem Call post build corel.bat <tool> <output dir> <project short name>

@rem E.g. in PSoC Creator 4.2:

@rem post build corel.bat creator ${OutputDir} S{ProjectShortName}
@echo ----------- - - - - --=---"-"---"-"-"-"-"-"-"—"""--"-"——"———

@echo Post-build commands for Cortex-M4 core

@echo —-—-—====—--—-——————— -

@rem Set proper path to your PDL 3.x and above installation

@set PDL PATH="C:\Program Files (x86)\Cypress\PDL\3.0.1"

@set CY MCU ELF TOOL=%PDL PATH%"\tools\win\elf\cymcuelftool.exe"

@set IDE=%1
@if "SIDES" == "creator" (

@set OUTPUT DIR=%2
@set PRJ NAME=%3
@set ELF EXT=.elf

@if "$IDE$" == "uvision" (
@set OUTPUT DIR=%2
@set PRJ NAME=%3
@set ELF _EXT=.axf
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@if "S$IDES" == "iar" (
@set OUTPUT DIR=%2
@set PRJ NAME=$%3
@set ELF_EXT=.out

@if "$IDES%" == "eclipse" (
@set OUTPUT DIR=%2
@set PRJ_NAME=%3
@set ELF EXT=

$CY MCU ELF TOOL% -S $OUTPUT_ DIR%\$PRJ NAME$$ELF EXT$ CRC

$CY MCU ELF TOOL% -P $OUTPUT DIR%\%PRJ NAME$SELF EXT$ --output
$OUTPUT DIR%\%PRJ NAME%.cyacd2
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